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PacTerm for Windows

PacTerm for Windows Help

Help on using PacTerm for Windows is available at any time by selecting “Help Topics” from the
“Help” menu on the main PacTerm window or by pressing the F1 key.  When Help is open, you
can access the Table of Contents by clicking on the “Help Topics” button or you can search for a
particular keyword by clicking the “Help Topics” button and then using the “Index” or “Find” tabs.
For general help with Windows, click on the Windows Start button and select “Help”.

The following Help Topics on PacTerm for Windows are available:

Overview of PacTerm for Windows
Setting Up PacTerm for Windows
Starting PacTerm for Windows for the First Time
PacTerm for Windows Controls for VHF
PacTerm for Windows Controls for HF
HF Packet Session
Logging Programs
Getting Started with Rig Control
Troubleshooting
Technical Support
Windows Commands

Overview of PacTerm for Windows

For Windows 95, Windows 98, Windows Me, Windows NT, Windows 2000, and Windows
XP

PacTerm for Windows is a 32-bit Kantronics Host Mode based terminal program.  Host Mode
allows the TNC to communicate with computer software that is more sophisticated than standard
terminal programs.  PacTerm for Windows takes advantage of true multitasking in Windows 95,
Windows 98, Windows Me, Windows NT, Windows 2000, and Windows XP and uses standard
Windows commands for ease of use.  It allows for multiple streams on multiple ports including
VHF Packet and HF Non-packet Modes.  HF Modes include CW, RTTY, ASCII, AMTOR,
PACTOR, GTOR, NAVTEX, FEC, PSK31, KAM XL PSK31, Listen AMTOR, and GTOR
Monitor when using a KAM.  Features of PacTerm for Windows include:

• Interoperability with Log Windows and Dx4Win 4.06

• Save QSOs to a file that is compatible with Microsoft Word
• Multi-stream multi-port support.  Up to 26 streams per packet port, each in a different

window

• Separate window for non-packet HF modes, from CW through NAVTEX, with mode
selection at the click of a mouse

• Switch between streams with a click of the mouse
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• Multiple monitor windows allow you to watch traffic on each radio port

• Supports COM1 to COM35

• Basic radio control

• User defined colors and fonts

• Supports GTOR and GTOR Monitoring

• Supports PSK31 using your TNC for keying

• Interoperability with AGW Packet Engine

• Text and binary file transfers with YAPP

• User defined macros

• Supports the KAM XL PSK31 mode

• Autologging to Log Windows and DXBase 2002

PacTerm for Windows will support all Kantronics TNCs with Firmware 5.0 or greater, and
KAMs with Firmware 7.0 or greater.  For PacTerm to run on your system you will need
Windows 95, Windows 98, Windows Me, Windows NT 4.0,  Windows 2000, or Windows XP.

If you are not familiar with Windows and need more information on it, check your Windows help,
accessible from the Windows Start menu.  If you need more information on your TNC, consult
your Kantronics TNC Owners Manual.

If you are using a KAM 98, neither the VHF nor HF view will be open when you first open
PacTerm for Windows.  Simply click on the File menu and choose whether you want the HF or
VHF view.

If you use a single port KPC 3, then a VHF window will appear at startup.  If you are using a KPC
9612 or a Kantronics Data Engine, then a Port 1 and Port 2 window session will appear at startup.

If you are using a KAM, then a HF and a VHF session window will appear at startup.

Installation of PacTerm for Windows

If you received a CD:

1) Insert the CD into your CD drive, and wait for the AutoRun program to start.

2) Follow the instructions on the screen to install PacTerm for Windows.

If you received diskettes:

1) Place Disk One in drive A:  (or drive B: depending on your system)

2) Click on the Windows Start button to begin 

3) Click on the Run option
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4) Type   “ A:\setup.exe” (or “B:\setup.exe”) and click the OK button.  This will begin the
installation of PacTerm for Windows

5) Follow the directions for the setup.  It will prompt you for information you need to complete
installation.

After installation is complete, double click on the PacTerm for Windows Icon to begin the
program.

6) You will be prompted to enter your call sign and the Serial Number and Activation Key you
received when you registered your software.  You are able to register up to 10 different call
signs for yourself and members of your family living in the same house.  You will also need to
select the Registration Set.  The Registration Set is used if more than one call sign is used.  To
select the Registration Set to use, click on the left and right arrow keys.  You will need to
enter your call sign and the Serial Number and Activation Key for each call sign to access the
full capabilities of PacTerm for Windows.  NOTE:  Activation key is case sensitive.
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7) If you don’t have a Serial Number or Activation Key, you will still be able to run the program,
but only in Demo Mode.  Demo Mode allows you to operate packet only using single port,
multi-stream without any of the advanced features of the program.  Click on the Demo Mode
button to continue in Demo Mode.

8) You will be prompted to enter your computer’s COM port and baud rate for the TNC.  This
allows you set which COM port your TNC is using and the baud rate.  PacTerm for Windows
supports COM1 through COM35.  Make sure your TNC is connected to the COM port that
you choose and make sure your choose the same baud rate that is set in your TNC.
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9) Now you are ready to begin using PacTerm for Windows.

Demo Mode

Demo Mode is the mode of PacTerm for Windows that allows single port multiple streams in
multiple windows.  It is the free mode of the program.  To access it, click the Demo Mode button
on the Registration dialog box after you enter your call sign.  None of the advanced features of
PacTerm for Windows are available in this mode, but you will be able to connect and disconnect to
packet only stations by using the F2 key, which toggles command and converse mode.
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Register Software

You are able to register up to 10 different call signs for yourself and your family living in the same
house.  For each call sign, you will also need to select the Registration Set.  The Registration Set is
used if more than one call sign is used with the program.  To select which Registration Set to use,
click on the left and right button arrow keys.  You will need to enter your call sign and your Serial
Number and an Activation Key to access the full capabilities of PacTerm for Windows.  NOTE:
Activation key is case sensitive.  Each call sign will need its own activation key. After entering the
information for each Registration Set, click the Apply button to save the information.  If you want
this screen to come up each time you start PacTerm for Windows, make sure there is a check mark
beside “Show this window at startup”.  Click the OK button when you are finished with this
screen.

 If you have not registered PacTerm for Windows yet, type in your call sign and click the “Demo
Mode” button to start the program in Demo Mode.

Starting PacTerm for Windows the First Time

If this is your first time using packet radio, you might want to try connecting to your own
Mailbox first.  After completing the installation of the program and TNC, you can start PacTerm
for Windows using one of the methods below:

• By double clicking on the PacTerm for Windows icon on your desktop .
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• By clicking on the Windows Start menu .  Select Programs and then click on the

PacTerm for Windows menu item.

• By using Windows Explorer.  For more information on this, consult Windows Help.

After the program comes up, the first item you will see is a dialog box that prompts for your call
sign, serial number, and activation key.

If you downloaded PacTerm from the web, you won’t have an Activation Key or Serial Number.
Just enter your call sign and click the Demo Mode button.  If you have an Activation Key and a
Serial Number, enter them and click the OK button.  The program will then ask for the COM port
where the TNC is connected and the baud rate to use to communicate with the TNC.  The baud
rate should be the same as the baud rate set in the TNC.  The program should now come up.  If it
doesn’t, check information in the Troubleshooting section of this manual.

Now that you have finished entering the requested information, it’s time to begin the program.
When opening PacTerm for Windows for the first time, you will see a large program window
near the top of your monitor.  Near the bottom of the program window you will see a small chat
buffer (the default color of this window is white), and a larger receive text buffer at the top (the
default color of this window is blue).  The bar that separates the two windows is the splitter bar,
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it can be moved up and down to resize the windows to your preference.  NOTE:  When making
a packet connection, text you receive will appear in the text buffer.  Commands and text you
enter will appear in the chat buffer.  All results of the commands or text entered by you will
appear in the Command window.  The Monitor window monitors the traffic on the packet radio
port.

How to Report Bugs

We would appreciate feedback from you.  If you find a problem with the software that you think
may be a bug, please let us know.  You can reach us at bugs@cssincorp.com.
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Windows Commands

Basic Windows Commands

PacTerm for Windows uses a standard 32-bit Windows interface.  For general information and help
about using Windows, see your Windows Help accessible from the Windows Start menu.
Windows commands covered here that are specific to PacTerm for Windows include the following:

Open File
Close
Save
Save As
Print
Print Preview
Print Dialog Box
Print Preview Toolbar
Print Setup
Cut
Copy
Paste
Cascade
Tile
Arrange Icons
About Box
Exit
Status Bar
Toolbar

Open File Command

Use this command to open a document.

Shortcuts

Toolbar:

Keys: CTRL+O

Close Command

Use this command to close the current session.  You can also close a session by using the Close
button on the document’s window, as shown below:
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Save Command

Use this command to save the current active session.  When you save a document, PacTerm for
Windows displays the Save as dialog box so you can name your document.

Shortcuts

Toolbar:

Keys: CTRL+S

Save As Command

Use this command to save and name the active session.  PacTerm for Windows displays the Save
as dialog box so you can name your document.  It can be saved in Rich Text Format (.RTF) or
Text Format (.TXT) format.

Print

Use this command to print a session.  This command presents a Print dialog box where you may
specify the range of pages to be printed, the number of copies, the destination printer, and other
printer setup options.

Shortcuts

Toolbar:

Keys: CTRL+P

Print Preview

Use this command to display the active session as it would appear when printed.  When you
choose this command, the main window will be replaced with a print preview window in which
one or two pages will be displayed in their printed format.  The Print Preview toolbar offers you
options to view either one or two pages at a time; move back and forth through the document;
zoom in and out of pages; and initiate a print job.

Print Dialog Box

The following options allow you to specify how the document should be printed:
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Printer

This is the active printer and printer connection.  Choose the Setup option to change the printer
and printer connection.

Setup

Displays a Print Setup dialog box, so you can select a printer and printer connection.

Print Range

Specify the pages you want to print:

All Prints the entire document.

Selection Prints the currently selected text.

Pages Prints the range of pages you specify in the From and To boxes.
Copies

Specify the number of copies you want to print for the above page range.

Collate Copies

Prints copies in page number order, instead of separated multiple copies of each page.

Print Quality

Select the quality of the printing.  Generally, lower quality printing takes less time to produce.

Print Progress Dialog

The Printing dialog box is shown during the time that PacTerm for Windows is sending output to
the printer.  The page number indicates the progress of the printing.

To abort printing, choose Cancel.

Print Preview Toolbar

The Print Preview toolbar offers you the following options:

Print

Bring up the print dialog box, to start a print job.

Next Page

Preview the next printed page.

Prev Page

Preview the previous printed page.

One Page / Two Page

Preview one or two printed pages at a time.
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Zoom In

Take a closer look at the printed page.

Zoom Out

Take a larger look at the printed page.

Close

Return from print preview to the editing window.

Print Setup

The following options allow you to select the destination printer and its connection.

Printer

Select the printer you want to use.  Choose the Default Printer; or choose the Specific Printer
option and select one of the current installed printers shown in the box.  You install printers and
configure ports using the Windows Control Panel.

Orientation

Choose Portrait or Landscape.

Paper Size

Select the size of paper that the document is to be printed on.

Paper Source

Some printers offer multiple trays for different paper sources.  Specify the tray here.

Options

Displays a dialog box where you can make additional choices about printing, specific to the type of
printer you have selected.

Network...

Choose this button to connect to a network location, assigning it a new drive letter.

Cut Command

Use this command to remove the currently selected data from the session and put it on the
clipboard.  This command is unavailable if there is no data currently selected.  You cannot cut
data from the (blue) receive text window because this is a read only window.  You can cut text
from the (white) chat window.  NOTE:  These are the default colors and can be change by the
user.

Cutting data to the clipboard replaces the contents previously stored there.

Shortcuts
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Toolbar:

Keys: CTRL+X

Copy Command

Use this command to copy selected or highlighted data onto the clipboard.  This command is
unavailable if there is no data currently selected.  Select text to copy by placing your mouse
cursor at the beginning of the text, holding down the left mouse button, and dragging the mouse
over the text to be copied.  This command can often be found from the Edit menu or from the
right mouse click menu.

Copying data to the clipboard replaces the contents previously stored there.

Shortcuts

Toolbar:

Keys: CTRL+C

Paste Command

Use this command to insert a copy of the clipboard contents at the current mouse cursor position.
This command is unavailable if the clipboard is empty. This command can often be found from
the Edit menu or from the right mouse click menu.

Shortcuts

Toolbar:

Keys: CTRL+V

Cascade Command

Use this command to arrange multiple opened windows in an overlapped fashion.

Tile Command

Use this command to arrange multiple opened windows in a non-overlapped fashion.
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Arrange Icons

Use this command to arrange the icons for minimized windows at the bottom of the main
window.  If there is an open document window at the bottom of the main window, then some or
all of the icons may not be visible because they will be underneath this document window.

About Box

The About box tell you who the software is licensed to, what model of Kantronics TNC is
attached, and the version of firmware the TNC has.

Exit

From the Packet window, the Exit command exits from the program.  If you have any open
windows (connected to a packet station) they will not be disconnected when you exit.  You will
need to disconnect before Exiting from the HF window; Exit will close the active HF window and
will disconnect.
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Status Bar

VHF Status Bar

                  A.                                                             B.                               C.

D. E. F.     G.            H.

The status bar is displayed at the bottom of the PacTerm window.  To display or hide the status
bar, use the Status Bar command in the View menu.

The following is a description of each part of the status bar:

A.  Emulates the TNC cmd: Converse Mode by pressing F2.

B.  Shows which Port and Stream the session is using.

C.  Connection status.

D.  Press F1 for Help.

E.  Lists the current mode, Host or Terminal.

F.  Local time

G.  UTC (GMT)

H.  Free bytes in the TNC’s buffer.

Non-Packet HF Status Bar

                                                                         A.    B.    C.

A.  Shows which non-packet mode you are using.

B.  Additional information about that mode.

C.  TNC status.
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Toolbar

This is the VHF Toolbar:

This is the HF Toolbar:

The toolbar is displayed across the top of the application window, below the menu bar.  The
toolbar provides quick mouse access to many tools used in PacTerm for Windows and to the HF
modes in the TNC.

To hide or display the Toolbar, choose Toolbar from the View menu.

Keystroke: <Alt-V> and <T>).

Click To

Open a new session.

Open an existing document.  PacTerm for Windows displays the Open dialog

box, in which you can locate and open the desired file.

Save the active session with its current name.  If you have not named the

document, PacTerm for Windows displays the Save As dialog box.

Print the active session.

Remove selected data from the session and stores it on the clipboard.

Copy the selection to the clipboard.

Insert the contents of the clipboard at the text cursor.
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General Information

Entering Your SELCAL

The KAM allows you to change the MYSELCAL or the MYGROUP SELCAL with the
commands MYSELCAL or MYGROUP respectively.  These two commands allow you to set
your 4-character SELCAL by entering a 4-character string, a 4-digit number or a 5-digit number.
You also use these commands to change your 7-character SELCAL by entering a 7-character
string, a 9-digit number, or an amateur radio Call Sign.

No matter which method you use, the KAM will attempt to create a valid SELCAL from the
information.  If you use a call sign, the KAM will always succeed at creating both the character
equivalent and the numeric equivalent.  If you enter either the numeric form or the character form
of the command, there may not be a valid call sign equivalent.  (If the generated or entered
numeric value is 913330047 or less, the KAM will have the call sign field filled in.)

When you display the MYSELCAL and MYGROUP, the KAM shows you all of the valid
SELCALs that exist.  The 4-character SELCAL is first, followed by a comma, and then the 7-
character SELCAL.  With each of these, the numeric equivalent (if one exists) will be displayed in
parenthesis, and for the 7-character SELCAL, the Call Sign will be displayed in square brackets
(if one exists).  For instance, if I have set my SELCAL from the HF Non-packet Settings menu
with NGDO, and then again set the SELCAL with N4GDO, the KAM would display:

MYSELCAL NGDO, OXDQRBS (902102629) [N4GDO]

Here we see the 4-character SELCAL (NGDO) and no numeric equivalent, since none exists.
We also see the 7-character SELCAL (OCIFRDC), its numeric equivalent (917670766) and the
call sign (N4GDO).

If the 4-character SELCAL also has a numeric equivalent, it would be displayed in parenthesis
before the comma.  Now if I were to issue the command MYSELCAL KWGU the resulting
display would show:

MYSELCAL KWGU (688868254), OXDQRBS (902102629) [N4GDO]

If you enter a numeric or character SELCAL for the 7-character version and that entry does not
convert to a call sign according to the conversion algorithm, you would see something like:

MYSELCAL NGDO, OOFFVZP (902102629)

It is even possible to enter a SELCAL that contains all valid characters, but does not translate to
a valid numeric equivalent according to the CCIR 625 recommendation.  For instance, entering a
SELCAL of AAAAAAA results in the following display:

MYSELCAL NGDO, AAAAAAA

This same method of entering a SELCAL applies using the MYGROUP command as well.  This
allows easy entry of either the 4-character or 7-character SELCALs with a single command.
Notice here that you would need to use the MYSELCAL command or MYGROUP command
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twice to set both the 4-character and 7-character SELCALs.  Giving the MYSELCAL command
with an argument will only change the appropriate 4- or 7-character SELCAL and will not affect
the other SELCAL.

Creating a Unique SELCAL from an Amateur Call Sign

The KAM will create a unique SELCAL (CCIR 625) from an amateur radio call sign.  Although
there is no “standard” for this procedure, the algorithm used by the KAM will create a unique
SELCAL for every call sign.

This section describes the algorithm in detail, allowing you to understand how the SELCAL is
created.  First, some description of what is permissible as an “amateur call sign” is in order.  For
purposes of generating a SELCAL, every amateur call sign will contain 6 characters and/or
numbers.  If the real amateur call sign is shorter than 6 characters, the remaining characters are
filled with spaces.

The first three characters must be either alphabetic characters (A-Z) or numbers (0-9).  No
spaces are permitted in the first three characters.  The remaining three characters must either
contain alphabetic characters (A-Z) or spaces.  No numbers are permitted.

The first step in creating a unique SELCAL is to convert the amateur call sign to a unique
number.  To do this, we must assign a value to each possible character in the call sign.  The
values are assigned as follows:

A = 0 G = 6 M = 12 S = 18 Y = 24 4 = 30
B = 1 H = 7 N = 13 T = 19 Z = 25 5 = 31
C = 2 I = 8 O = 14 U = 20 0 = 26 6 = 32
D = 3 J = 9 P = 15 V = 21 1 = 27 7 = 33
E = 4 K = 10 Q = 16 W = 22 2 = 28 8 = 34
F = 5 L = 11 R = 17 X = 23 3 = 29 9 = 35
SPACE = 26 (Not Allowed In First Three Characters)

We begin with the last character of the call sign and multiply this by 27.  Next add the value for the
next to last character, and then multiply the result by 27 again.  Now add the value of the 4th
character of the call sign and multiply by 36.  Add the value of the 3rd character and multiply by 36
again.  Add the value of the 2nd character and multiply by 36.  Now the final step is just to add the
value of the first character.  This gives you a unique nine-digit numeric SELCAL.

Let’s walk through a couple of examples.  Using N4GDO for the call sign, we need to use the call
“N4GDO  “, since it is only a four character call sign.  (Two spaces are added to the end).  First
let’s determine the value for each character:

N=13 4=30 G=6 D=3 O=14  SPACE=26

Then we calculate the unique 9-digit number:

6th value (26) 26
times 27 (26 * 27) 702
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plus 5th value (702 + 14) 716
times 27 (716 * 27) 19332
plus 4th value (19332 + 3) 19335
times 36 (19335 * 36) 696060
plus 3rd value (696060 + 6) 696066
times 36 (696066 * 36) 25058376
plus 2nd value (25058376 + 30 25058406
times 36 (25058406 * 36) 902102616
plus 1st value (902102616 + 13) 902102629

The final 9-digit SELCAL is 902102629

Now let’s look at a different call sign.  Let’s use KF4WGU.  The character values are:

K=10 F=5 4=30 W=22  G=6 U=20

Now we calculate the unique 9-digit number:

6th value (20) 20
times 27 (20 * 27) 540
plus 5th value (540 + 6) 546
times 27 (545* 27) 14742
plus 4th value (14742 + 22) 14764
times 36 ( 14764* 36) 531504
plus 3rd value (531504 + 30) 531534
times 36 (531534 * 36) 19135224
plus 2nd value (19135224 + 5) 19135229
times 36 (19135229 * 36) 688868244
plus 1st value (688868244 + 10) 688868254

The final 9-digit SELCAL is 688868254

Now that we have the 9-digit SELCAL, we can use the CCIR 625 specification to determine the
corresponding 7-character SELCAL.  To accomplish this, we must perform similar steps to the
above.  In this case we first must know the value for each of the valid CCIR 625 characters as
defined by the CCIR recommendation.

V = 0 M = 4 F = 8 U = 12 R = 16
X = 1 P = 5 S = 9 E = 13 Z = 17
Q = 2 C = 6 T = 10 O = 14 D = 18
K = 3 Y = 7 B = 11 I = 15 A = 19

Now let’s convert the 9 digit SELCAL 90210262 (from the earlier example) to a 7 character
SELCAL.  To do this, we divide the 9-digit number by 20, and keep the remainder.  We continue
this process until the division results in zero.

9 digit SELCAL 902102629
divided by 20 (902102629/ 20) 45105131 Remainder:  9
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divided by 20 (45105131 / 20) 2255256  Remainder: 11
divided by 20 (2255256 / 20) 112762 Remainder: 16
divided by 20 (112762/ 20) 5638 Remainder:  2
divided by 20 (5638/ 20) 281 Remainder: 18
divided by 20 (281 / 20) 14 Remainder:  1
divided by 20 (14 / 20) 0 Remainder: 14

We form the 7-character SELCAL using the table above to convert the remainders to letters.  We
start with the bottom of the list of remainders above, so

14 = 0, 1=X, 18 = D, 2= Q, 16 = R, 16= R, 11 = B and 9=S.

The proper 7 character SELCAL is then OXDQRBS

Remember that there is no standard for converting amateur Call Signs into a “proper” SELCAL,
but this algorithm will provide a unique CCIR 625 SELCAL for every possible amateur Call Sign.
The KAM will even allow you to establish an AMTOR link with another station by entering the
Call Sign as an argument to the AMTOR command.  For example:

AMTOR N4GDO

would cause the KAM to try to establish a link to OXDQRBS.  If the other station is using the
default provided by the KAM, this will be his 7-character SELCAL.

Connecting to your own Mailbox

Connecting to the mailbox in your own TNC is the best way to practice connecting to a packet
station.  The radio does not have to be connected.  The following steps will allow you to make
your first connection.

1) Press F7.

2) Type in your call sign plus a dash one (-1).  This is default for the TNC’s PBBS.  Example:  If
your call sign is N4GDO you need to type N4GDO-1 in the Call Sign to connect to box.

3) Click the Connect button.

4) Now you are connected to your mailbox.  If your screen doesn’t look similar to the following
consult the Troubleshooting section of this manual.

CONNECTED to N4GDO-1 [09/29/97 12:49:31]
 [KAMP-8.2-HM$]
100000 BYTES AVAILABLE
THERE ARE NO MESSAGES
ENTER COMMAND: B, J, K, L, R, S, or Help >***

Now you can enter any of the mailbox commands shown (B, J, K, L, R, S, or Help).  Later you
will want to read the PBBS section of the TNC Reference Manual for more details.  If you type
the HELP command and press <Enter>, you will see the mailbox help files and then the standard
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mailbox prompt.

ENTER COMMAND: B, J, K, L, R, S, or Help >.

Now disconnect from the mailbox by first pressing F2.  Now you will see the cmd: prompt.  Next
you type “d” and press <Enter>.  You will now receive the message

*** DISCONNECTED [09/29/97 13:08:37].

Understanding the HF TOR Modes

Operating the HF TOR Modes

With Solar Cycle 23 raising its sunny head, radio amateurs are beginning once again to enjoy the
“sport” of making digital Mode contacts world-wide on the HF bands.  With lots of “chirp-chirp-
chirp” being heard on the data portions of these bands, it’s a good time to review the operational
basics of the teletype over radio (TOR) Modes, now the most prominent digital Modes along
with ever popular radio teletype (RTTY).

The first thing to note is that operating procedures for the TOR Modes are essentially the same as
listening and making voice contacts.  You tune around the bands until you hear digital activity,
issue a command to your multi-mode controller to monitor (copy).  Then see what the stations
are talking about (you “read the mail”).  If it’s a station calling CQ, you answer that station or
you call CQ and wait in standby for an answer.  Second, operations of the TOR Modes are pretty
much alike.  A command must be entered to monitor, to issue a link request, to call CQ, or to
stand by after calling a CQ.  The difference is that the commands to initiate these actions are
named differently for each mode.  Once one of these commands has been issued, further action is
taken by issuing a directive.   For basic operations the directives are the same for all TOR Modes.
For example, the directives to transmit, to quit a QSO, or to change information direction are the
same for all of the TOR Modes.

To monitor AMTOR, PACTOR, or GTOR transmissions, you will have to enter a monitor mode.
For example, to listen to PACTOR link requests or a QSO in PACTOR, you would click on the
PACTOR listen button or choose PACTOR from the Mode menu.

To break a link (finish the QSO), you would click on Disconnect in the appropriate menu to
abort the link or quit the TOR mode.

If the station you are monitoring is calling CQ and you wish to make contact, you will then issue
a link request, again with a command specific to that mode.  For example, suppose you hear
W0XI calling CQ in AMTOR.  To link with him, you would click the link option in the AMTOR

menu, type in W0XI, and press <Enter>.  You can also click the Link button .

If you wanted to call CQ yourself, you would enter Standby mode for AMTOR by clicking on the

AMTOR button  on the toolbar and then click on the Transmit button , or press F4, to
make your radio transmit.  Then type your CQ message:
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CQ CQ CQ DE “your Call Sign” K.

You may repeat that line several times.  Then, put your controller in Standby (and return the

radio to Receive Mode), by clicking the Receive button  or pressing F5.

You are now ready to take on Solar Cycle 23 and operate one of the TOR Modes.  Good
hunting.

AMTOR Theory

Information transmitted by AMTOR is specially encoded to provide a scheme of error detection.
This coding takes the form of each character containing 4 SPACE signals and 3 MARK signals.
The receiving station can use this 4/3 ratio to determine if the character received is “probably”
correct. If the received signal were to arrive with 4 MARK and 3 SPACE signals, the signal is
obviously in error, and the receiving station could take the appropriate action.  The information is
transmitted in blocks of 3 characters; that is, the sending station will transmit 3 characters and then
pause for an answer from the receiving station.  The answer will consist of a single character,
indicating that the block just sent was either received OK or that the block should be
retransmitted.

AMTOR operation is possible in two basic modes.  Mode A operation is a one-on-one mode,
enabling the receiving station to request retransmission of any received characters that contain
errors.  This mode provides a high degree of error immunity due to the handshaking between the
two stations involved in the communication.  This mode is commonly referred to as ARQ.

Mode B operation is similar to RTTY operation, in that the signals are not error-checked by a
specific station and no handshaking is performed. Mode B is the mode used for calling CQ, or
other operations, where more than one station is intended to receive the communication.  Mode
B operation is called FEC — Forward Error Correction.  In this mode, each character is sent
twice, and the receiving station will check each character for the proper 4/3 ratio.  If the first
character received is correct, the receiving station stores it and then looks at the repeat of that
character.  If it is also correct and it matches with the first character, it is printed.  If one of the
two was correct and the other did not have the proper MARK/SPACE ratio, the correctly
received character is printed.  If both characters were received incorrectly, then the MISSCHAR
is printed.  If both were received correctly, but they don’t match, the MISSCHAR is also printed.
In the KAM, the default MISSCHAR is a SPACE, but you may choose any character you wish
with the MISSCHAR command.

A variation of Mode B operation is called SELFEC — Selective FEC.  In this mode, the sending
station transmits the SELCAL of the intended receiving station for a specific time interval.
During this time, all stations that hear the signal compare the SELCAL being received with their
own SELCAL.  If they match, printing of data is enabled.  Otherwise the receiving station returns
to a standby mode and doesn’t copy the signal.  In addition, when the sending station starts to
transmit the data, it automatically inverts the MARK and SPACE tones, resulting in four MARKs
and three SPACEs.  Other stations that tune in during the SELFEC transmission cannot lock to
this signal.
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AMTOR stations are each identified with a SELCAL — the selective call sign used to identify
this station from all others.  In most other amateur communication, we think of the call sign being
used for this purpose, but in AMTOR, the SELCAL is normally composed of the first letter of
your call and the last three letters of your call.  Thus the SELCAL for KF4WGU would be
KWGU.  If your call sign does not contain four letters, the standard practice is to duplicate the
first letter of the SELCAL.  Thus W4PC would have a SELCAL of WWPC.  The SELCAL is
used in both the SELFEC and ARQ Modes of operation.

With the implementation of the CCIR 625 recommendation for AMTOR operation, the SELCAL
may now contain 7 characters.  This SELCAL cannot include the characters G, H, J, L, N, and W.
The reasons for this are contained in the Consultive Committee on International Radio document
“CCIR Recommendation 491-1” which describes a TOR station identification.

When you first enter your call sign into the KAM, the KAM will create your 4-character
SELCAL as described above and will also generate a unique 7-character SELCAL using a
Kantronics-designed method, which guarantees a unique SELCAL for every amateur call sign.
The method used is described at the end of this section (Creating a Unique Selcal).  These
SELCALs are defaults for the MYSELCAL and MYGROUP parameters.

AMTOR ARQ (Mode A) operation requires that both stations transmit alternately.  First the
Information Sending Station, or ISS (the station actually sending data), sends three characters.
This requires 210 milliseconds.  This station then enters the receive mode and it listens for the
acknowledgment from the Information Receiving Station, or IRS.  The sending station will wait
240 milliseconds for acknowledge.  After this 240 millisecond delay, the sending station will again
enter transmit and send the next (or the same) three characters.

Since both stations are constantly switching between receive and transmit, fast switching times
are required for AMTOR ARQ operation.  You can adjust TXDAMTOR to allow for the time
required for your station to change from receive to transmit, but you should allow a small extra
amount time for the other station to switch from transmit to receive.  Regardless of the setting of
this parameter, the total turn around time for one AMTOR data/ack cycle remains 450
milliseconds.

AMTOR Translation Table

Since AMTOR does not support the full ASCII character set, specifically many characters that
exist in packet BBS mail messages, the KAM now translates characters according to the
following chart:

Packet Character AMTOR Transmitted
‘ or @ =
< [ or { (
> ] or } )
; not transmitted
“ ‘ (apostrophe)
% not transmitted
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* not transmitted
\ or | /
^ or ~ not transmitted
_ or delete (7F) - (dash)

Tuning AMTOR

AMTOR signals are very similar to RTTY signals in that they are transmitted with MARK and
SPACE tones, and therefore the barograph indicator will light both ends of the barograph when
properly tuned in.  If the station you are tuning is in Mode A, the barograph will seem to flash on
and off as the station alternately transmits and then receives.  Once a station is properly tuned,
the LOCK and VAL lights on the KAM will light.  Once you have this LOCK condition, the
KAM will start sending data to your terminal.  The VAL light may go out at times, indicating that
invalid characters have been received.  If you have the station tuned properly, but nothing prints
on your screen, it may be because once LOCK has been achieved, the KAM also waits until it
receives a carriage return before it starts printing.  You may also try the invert function by using
the Invert menu option.  You can change the shift being used by using the Shift menu option,
which will allow you to choose the shift.  Most AMTOR is sent with a standard 170-Hertz shift.

AMTOR PBBS Operation

The KAM allows your PBBS to be accessed by another station using AMTOR Mode A (ARQ).
In order for this to occur, you must have your PBBS enabled (see the PBBS section of the
Operations manual) and you must set the ARQBBS command ON.  If a station links to one of
your SELCALs when you have the ARQBBS on, that station will be linked to your PBBS instead
of your keyboard.  If you want to monitor an AMTOR station that is using your PBBS, you use
the MONITOR and XMITECHO commands.  The MONITOR command lets you monitor the
incoming data and the XMITECHO command allows monitoring of the OUTGOING data.

NOTE: If using AMTOR to enter standby, you cannot monitor any FEC transmissions when the
ARQBBS command is ON.

See the PBBS section of the KAM manual for more details about the PBBS.

AMTOR Information

AMTOR is one of three Teletype Over Radio (TOR) modes supported by the KAM Plus or the
KAM with an enhancement board.  Operationally, AMTOR, PACTOR, and GTOR are similar.
Commands exist in each mode for monitoring (other stations), for standby (to receive a link
request), and for initiating a link (connect).

Action Command
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To monitor AMTOR or (SITOR) use 

To receive a linked request or

   go to AMTOR standby to call CQ use 

To initiate a link use 

To listen to AMTOR activity or to make an AMTOR contact using PacTerm for Windows, start
by opening a HF Non-packet session using the pull-down File menu.

LAMTOR:  Once the screen is opened, click the Listen AMTOR button  on the toolbar to

enter the Listen AMTOR (monitor) Mode.  Once the mode is set, LAMTOR will appear on the
status bar at the bottom on the HF screen (just above the task bar).  To monitor (copy other
stations), tune your receiver (LSB for amateur operations, USB for some commercial services)
until the MARK and SPACE tones light both ends of the MODEM bar graph.  To quit
LAMTOR, simply click on another mode or close the HF window.

You are set to receive a link request from another station or you may click the Link button  to

initiate a link.  (For commercial SITOR operations, tune in the bar graph when a transmission is
heard to see if it is a “free” signal).

AMTOR:  To make an AMTOR connection, click the AMTOR button  (if not in that mode

already) and then click the Link button .  A box will then appear for you to enter the SELCAL

of your contact.  Phasing to link (connect) follows.

TO BREAK THE LINK: Click the Disconnect button .

SENDING TO RECEIVING DATA WHILE IN AMTOR: The station that initiates the AMTOR

link starts as the Information Sending Station (ISS) .  The station receiving a link request and

linking starts as the Information Receiving Station (IRS) .  As ISS you may send information

by typing text in the chat window.  Once you have finished typing the text you want to send, you
can press either the ISS or the IRS button to change to information direction  (OPTIONAL: Or
you can type a <+> and a <?> to cause the AMTOR link to change information direction.  Once
you have done that, the link will sound different and your status bar will reflect your station as
IRS.  You can capture status as ISS by once again typing  <+> and a <?>.  Note: To type in text,
you must place your cursor in the chat window.

To call CQ, click the AMTOR button .  After you are in AMTOR Standby Mode, click the

Transmit button  to call CQ.  Click on the Receive button  to return to AMTOR standby,
ready to be linked.
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AMTOR Operation

There are three methods of entering AMTOR Mode of operation from PacTerm for Windows,
depending on which mode of AMTOR operation you wish to use.

Clicking on the LAMTOR button will allow you to receive Mode A (ARQ) and Mode B (FEC
and SELFEC) AMTOR signal, but this mode does not support transmitting.  If you are receiving
Mode A AMTOR, you may see repeated characters, or miss characters completely, since you are
not a part of the link.  The two stations which are linked may be requesting retransmission (thus
you see repeated characters) or they may have received the characters and you didn’t due to band
conditions.  In this listen-only mode; you may receive characters that do not meet the 4/3
SPACE/MARK ratio or characters that do not properly decode in the AMTOR character set.
These will be displayed on your screen as the MISSCHAR, which is defined in your KAM.

The second method to enter AMTOR operation is to use FEC by clicking on the FEC button
which places you in the Mode B receive.  In this mode you may receive FEC transmissions.  To

enter transmit mode, press the Transmit button  or the F4 Key.  You can then enter any text

you wish to send from the keyboard (in the chat window) and return to receive mode with the

Receive button  or the F5 Key.

You can also initiate a SELFEC transmission.  Pick the AMTOR menu and select the “SELFEC”
option.  This will bring up a dialog box in which you will enter the SELCAL of the station to
connect to.  You will automatically enter the transmit mode of FEC.  You would then send your

message, returning to receive with the Receive button  or the F5 key.  In order to enable your

unit to receive only SELFEC signals, you must turn AUTOSTRT ON.  Once you have started
receiving, you will stop upon the end of the transmission or upon losing lock with the FEC signal.
When AUTOSTRT is ON, the KAM will respond to a SELFEC transmission containing any of
the identifiers in the MYSELCAL or MYGROUP parameters.

To enter the Mode A AMTOR operation click on the AMTOR button  or select the Mode

menu and then AMTOR.  If you wish to link to a station, click on the Link button  or press

F7 and then enter the SELCAL.  This will cause your KAM to attempt to establish an ARQ link
to the station with SELCAL.  When you are attempting to link to another station, the KAM will
attempt the link for a specific length of time, controlled by the command ARQTIME.  The time
interval is set in increments of 64 ARQ cycles (approximately 28.8 seconds).  By default, this is
set to 2, which means the KAM will try for about 1 minute to obtain a response from the other
station.  You may set the ARQTIME from 1-10, selecting 30 seconds to 5 minutes for the
timeout interval.

If you want to initiate a call to another station, click the Link button  again.  The KAM also

will allow you to enter a Call Sign and will then attempt to link using the unique SELCAL
generated by the KAM.  For instance, the following three SELCALs all result in the KAM
attempting to link to the same station:

WD0EMR
SPSEQVQ
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593544802

When a station links to you, the KAM will display a message indicating that you are linked and
show you the character, numeric, and Call Sign equivalents of the other station (625 link only).
For instance, you might see a message from the KAM:

<LINKED to SPSEQVQ (593544802) [WD0EMR]>

The KAM will respond to any SELCAL contained in the MYSELCAL parameter for a Mode A
(ARQ) QSO.

If you simply enter the AMTOR Mode, you will enter the standby receive mode, in which you
will be able to receive FEC transmissions or your unit will respond to an ARQ call.  Note,
however, that if you have ARQBBS ON, you will not copy any FEC transmissions.  Also, if you
have AUTOSTRT ON, you will only copy SELFEC transmissions directed to your station.  You
can enter the FEC transmit mode from this standby condition, enabling you to call CQ by using

the Transmit button  or the F4 key.  This command puts your KAM in FEC transmit and any

characters you type will now be sent in FEC Mode.  After you have entered your CQ message,

you can use the Receive button  or the F5 key which will return you to the AMTOR standby

Mode after the transmit buffer is empty, allowing you to respond to an ARQ call answering your
CQ.  For instance, to enter AMTOR and call CQ, the sequence would be:

Click the Transmit button 

CQ CQ CQ DE N4GDO N4GDO N4GDO (NGDO) (NGDO) OR (OXDQRBS)
(OXDQRBS)
CQ CQ CQ DE N4GDO N4GDO N4GDO (NGDO) (NGDO) OR (OXDQRBS)
(OXDQRBS)
CQ CQ CQ DE N4GDO N4GDO N4GDO (NGDO) (NGDO) OR (OXDQRBS)
(OXDQRBS)

Click the Receive button 

If you then receive a call, your transmitter would begin responding automatically to the call, and
you would be the Slave station (since you did not initiate the link).  If the station linked to you
using the CCIR 625 format, you will receive a message indicating his SELCAL.  The station that
called you is called the Master, and is automatically the Information Sending Station (ISS).  Any
data he types will appear on your screen and the TNC handles requests for transmission of
incorrectly received data automatically.  When he is ready to have you transmit data to him, he
would enter the changeover sequence, which consists of the characters “+” and “?”.  You then
become the ISS and the other station is the Information Receiving Station (IRS).  You now type
your message to the other station.  When you are finished and want him to respond, you send the
changeover sequence.  Since the KAM automatically inserts the FIGURES shift for you, all you
need to type is “+?” to perform the changeover.  You can also use the ISS/IRS buttons to
perform the changeover.

While you are the IRS, it may at times be necessary to “seize” the link from the other station and
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become the ISS.  In order to do this while receiving, use the ISS/IRS buttons.  This will send a
special sequence to the other station and cause a changeover to occur.  The KAM also supports
the WRU (Who aRe yoU) function.  This function causes the other station to send a pre-defined
string containing information about his station.  In the KAM, this information is entered with the
WTEXT command.  To initiate the WRU function, use the WRU option on the AMTOR menu
while you are the ISS and then the remote station will send his information to you if his TNC also
supports this function.

After you have finished your conversation with the other station, you can disconnect with the

Disconnect button .  This will terminate the link and return you to AMTOR standby.

CW Information
Several parameters can be set for the default values you would like to use when entering the CW
Mode of operation. These parameters and their factory defaults are listed here for your reference.

CWBand 200
CWPtt OFF
CWSpeed 25
CWTone 750
PROsign $5C

If you want to change any of these, simply type the command name followed by the new value
you wish to use for your default (e.g. CWB 30).  Then you should PERM these changes to save
them so the KAM will remember them the next time you turn the power on.  The CWBAND
command will set the audio bandwidth (in Hertz) for the CW filtering.  The CWTONE command
sets the center frequency in the CWBAND for the audio tone.  CWSPEED controls the default
receive speed used if you enter the CW Mode with no optional speed specified.  The PROSIGN
command defines the character used as a “lead in” to indicate that the next two characters are to
be combined as a PROSIGN.

The CWPTT command allows the KAM to control the Push-To-Talk line connected to your
transceiver when operating in the CW Mode.  If you have this command OFF, then you must set
your transceiver in the CW Mode and then either turn the VOX on, or manually operate the
transmit/receive switch when you are going to transmit.  When this command is ON, the KAM
will key your radio to transmit mode by keying the PTT line whenever you click the Transmit

button .

To enter the CW operating mode of the KAM, click the CW button .  This will place the

KAM into receive mode at the default speed.  If you desire to enter CW Mode at a different
speed, just use the CW Speed menu option and enter the speed that you wish to use.  The KAM
will attempt to lock to the speed of the incoming CW signal, but in order for this to operate
quickly, the KAM must be set to within 20 WPM of the received signal speed.

After you enter the CW command, your screen will display the current transmit and receive speed.
Now tune in the station you wish to receive.  You should tune SLOWLY and watch the barograph-
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tuning indicator on the KAM.  When the station is properly tuned, the barograph should deflect
fully to the right.  Tuning will depend on several factors including receiver stability, internal
filtering in your receiver, the CWBAND setting of your KAM (audio bandwidth), and the speed
with which you turn the receiver’s tuning dial.  The most common problem encountered in tuning
CW with the KAM is moving the tuning dial too quickly for the KAM to indicate full deflection.
Once you have tuned to a station, the KAM will track the receive speed.  PacTerm for Windows
will automatically update.

After you have selected your desired transmit speed, you can enter the Transmit mode .  At
this point, the transmitter turns on and characters you type from the keyboard are sent over the
air at the specified speed.  A very useful command for non-packet mode operation with the KAM
is the XMITECHO command.  When this command is on, the characters you have typed on the
keyboard will be echoed to the terminal AS THEY ARE TRANSMITTED.  PacTerm for
Windows initializes this for you when the program starts up.

Often in CW operation, you may want to send special PROSIGNS.  Several common
combinations are available as single keystrokes from the keyboard and are listed below for your
reference.  For instance, if I wish to transmit the BT symbol, I would simply type an = on the
keyboard and the KAM will send the BT for me.

Symbol Abbreviation Meaning

+ AR End of Message
= BT Break or Pause
% AS Wait
& KA Attention
# SK End of Transmission
( KN Invitation to Transmit
* AA All After
! SN Attention

In addition to these pre-defined combinations, the KAM has several user-definable characters that
may be programmed to be sent with a single keystroke.  Also the same combination that’s sent
can be displayed with a user defined one- or two-character sequence when your KAM receives
that code combination.

The re-definable codes and default characters used for transmit and receive display are listed here
and in the commands Manual.

CODE TX RX CODE TX RX

**— $00 $00 *-*- $2A(*) $4141(AA)
—* $00 $00 —— $00 $00
***-* $21(!) $534E(SN) **-** $00 $00
**-*- $00 $00 **—* $00 $00
*-*** $25(%) $4153(AS) *-**- $00 $00
*-*-* $2B(+) $4152(AR) *-*— $00 $00
*—** $00 $00 *—*- $00 $00
*—* $00 $00 -**-* $2F(/) $2F(/)
-**— $00 $00 -*-** $00 $00
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-*-*- $26(&) $4B41(KA) -*—* $28(() $28(()
-*— $00 $00 —**- $00 $00
—*-* $00 $00 —*— $00 $00
—*- $00 $00 ***-*- $23(#) $534B(SK)
*-***- $00 $00

For instance, the code character *-*- in the above chart can be transmitted by typing the <*> key
on the keyboard, and when the KAM receives the code combination *-*- it will display “AA”.  If
you want to define any special combination from the above list, you would use the MORSE
command.  For example, let’s say I want to send the code combination —*-.  Whenever I press
the <@> key on my keyboard, and when I receive the same combination, I want to display
“KM”.  To make this definition, I would use the command:

MORSE —*- 64 7577

In this example, 64 is the decimal code for the “@” character and 75 is the code for “K” while 77
is the ASCII for “M”. The definition could also be entered in hex if desired.  An entry may be
deleted from the special definition by using the command MORSE (code) 00 0000.

When you are ready to return to Receive Mode, you click the Receive button  button.

You can use your KAM to practice CW with most HF transceivers on the market today.  Set up
your key, keyer, or bug connected to the key input of your HF transceiver and connect the
external speaker jack of your transceiver to the KAM.  Next, set your transceiver so that when
you press the key, it will generate a sidetone signal, allowing you to hear what you are sending.
You will want to be sure you are not actually transmitting at this time.  Many transceivers will
allow this by tuning outside the normal amateur bands since they will not allow transmitting out
of band.  You can turn the RF gain on your receiver down so you will not hear other stations that
may be on the frequency you have chosen.  By adjusting the KAM CWTONE command to the
frequency of your sidetone, your KAM will copy what you send and display it on your terminal
screen, just by entering the CW Mode.  After a little practice, you will find your CW sending
skills improving.

NAVTEX Information
NAVTEX transmissions are, in reality, Mode B AMTOR (FEC).  What makes NAVTEX unique
however, is the actual message format.  NAVTEX stations always transmit on 518 kHz LSB and
are typically located on the coastlines.  The American Radio Relay League (ARRL) is using this
same format to transmit their bulletins on a daily basis.  These are transmitted during their
scheduled teleprinter bulletins.

At the beginning of a NAVTEX (or AMTEX) transmission, the sending station will send a
preamble identifying the station that is transmitting, the type of message, and the message
sequence number.  The preamble would look like this:

ZCZC AG25

The ZCZC is always present, and the receiving unit sees this as an indication that the identifier is
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coming next.  The components of the identifier, as defined in the NAVTEX documentation are:

B1 B2 B3 B4

B1 is used to identify the station that is transmitting and consists of the letters A through Z.  B2
indicates the message class (A through Z).  Note that class A, B and D messages must always be
printed once.  B3 and B4 are the sequence numbers for the message, and will have values from
00 through 99.  Messages with sequence number 00 are always printed.  When the message
numbers reach 99, they wrap to 01 as the next number.

Currently operating NAVTEX stations are:

Halifax, Nova Scotia Guam
Boston, MA Honolulu, HI
New Orleans, LA Kodiak, AK
Miami, FL Astoria, OR
San Juan, PR Long Beach, CA
Chesapeake, VA San Francisco, CA

For NAVTEX messages, the currently assigned message classes are:

A Navigational warnings
B Meteorological warnings (storm warnings)
C Ice reports
D Search and Rescue Information
E Meteorological forecasts
F Pilot messages
G Decca message
H LORAN-C message
I Omega message
J Differential Omega message
Z QRU — no message on hand
K-Y Reserved

NOTE: K has been proposed for “other electronic navigational aid system message”

Once a message has been received from a particular station with less than a specified amount of
errors, it will not be printed again, as the receiving system keeps track of the message numbers it
has received.  If it then sees the same message class and number from the same transmitting
station, it will not output the message to the terminal.

For ARRL AMTEX bulletins, the defined B1 codes are:

A ARRL issued bulletins
C CRRL issued bulletins (Canadian)
I IARU issued bulletins
J JARL issued bulletins
S AMSAT issued bulletins
X Miscellaneous

and the currently assigned message classes are:
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A Emergency bulletins
B Priority bulletins
D Reserved
E DX bulletins
G General bulletins
K Keplarian bulletins
P Propagation forecasts
S Satellite bulletins
X Miscellaneous bulletins

NAVTEX/AMTEX Operation
To enter the NAVTEX/AMTEX Mode, you simply click the NAVTEX button .  At this point

you will see nothing on the terminal until a valid NAVTEX message is received.

Before entering the NAVTEX Mode you may specify which stations you wish to receive using
the NAVSTA command.  For instance, if I wish to copy AMTEX bulletins issued by ARRL, but
do not want those from other stations (CRRL for example), check only the “A” box in NAVTEX
originating station in NAVTEX settings.

You may also specify which message classes you wish to receive by using the NAVMSG
command.  If you want the Satellite bulletins and DX bulletins, check only the E and S boxes
under NAVTEX message class in NAVTEX settings.  Note that if you eliminate message classes
A, B, or D from the list of valid message classes, you will receive a WARNING message from the
KAM since the NAVTEX specification requires that these classes must be printed at least once.
To set your system to copy all message classes, type NAVMSG ALL.

The NAVERR command is used to specify the percent of errors allowed in a received message
before the KAM considers the message as not being received properly.

RTTY Information

RTTY is a 5 level (5 bit) Baudot code, which limits the number of possible characters to 32.  This
obviously does not provide enough combinations for all 26 letters of the alphabet and the
numerals and punctuation.  Therefore, in order to allow more combinations, two special
characters have been reserved as a FIGURES shift and LETTERS shift.  When you first enter the
RTTY Mode, the system is in the LETTERS shift, thus allowing normal alphabetic characters to
be typed.  When you type any numbers or punctuation, the KAM automatically inserts a
FIGURES shift prior to sending the character.  One FIGURES shift is sent prior to the beginning
of a string of numbers, but if a SPACE is typed, a new FIGURES shift will be required and will
automatically be sent.

The standard mechanical teletype machine always is “un-shifted” when it received a SPACE
character, thus any numerals or punctuation immediately following a SPACE will require a
FIGURES shift to insure that the receiving machine is in the FIGURES Mode.  The KAM
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simulates this un-shifting based on the setting of the USOS command.

When operating in RTTY, standard procedure is to transmit approximately one line of RYs prior
to actually typing your message.  This allows the receiving station time to properly tune his
station and adjust his receiving equipment.  This was particularly true with the older mechanical
units, but has carried over into today’s computer terminal RTTY operation.  A typical sequence
then, for calling CQ might look like this:

RYRYRYRYRYRYRYRYRYRYRYRYRYRYRYRYRYRYRYRYRYRYRYRYRY
CQ CQ CQ DE N4GDO N4GDO N4GDO
CQ CQ CQ DE N4GDO N4GDO N4GDO
CQ CQ CQ DE N4GDO N4GDO N4GDO K K K

The RY has been used for the synchronizing and testing purposes because in the 5 level Baudot
code, this represents a complete reversal of the bit pattern.  Therefore the receiving mechanical
machine had to completely reverse all levers and gears within the time frame of one character.  It
was felt that if the machine could do a complete reversal like this, it could copy any other
combination without problem.

RTTY is transmitted using FSK (Frequency Shift Keying) in which the two possible conditions
for each bit of data are sent as two distinct frequencies.  These are called MARK and SPACE and
the difference between these two frequencies is called the SHIFT.  Most amateur RTTY is
transmitted with a 170 Hz shift, but other common shifts used are 425 Hz and 850 Hz.  With
FSK, changing the actual carrier frequency of the transmitter generates the frequency. Another
method of transmitting RTTY is to generate the tone within a piece of equipment and then
modulate the carrier with the tones.  This is called AFSK (Audio Frequency Shift Keying).  The
KAM supports both methods of transmitting RTTY and ASCII signals as well as all three of the
standard shifts.  In addition, the KAM can use non-standard shifts by selecting SHIFT MODEM
and setting your own choice of MARK and SPACE tones.

ASCII Information

ASCII is an 8-bit code allowing 256 possible combinations and thus overcomes the shortcomings
of RTTY concerning numbers and punctuation.  Because all possible numbers, letters, and
punctuation can be defined within this set of combinations, no LETTERS or FIGURES shift is
required.  Transmission of ASCII is accomplished using FSK or AFSK as is done in Baudot
RTTY and many of the operational practices have been carried forward from RTTY to ASCII.

RTTY and ASCII Operation

RTTY and ASCII operation with the KAM is accomplished through the HF radio port.  Several
commands and special directives are used to control the operation of the KAM in RTTY or
ASCII operation.  The following commands (issued from the cmd: prompt) will set the defaults
for RTTY and ASCII operation:
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ASCBaud DIDdle LFSup
AUtocr Echo LOwtones
AUTOStrt FSKinv MYAUtost
Ccitt INvert RBaud
CRAdd LCRtty USOs
CRSup LFAdd XMitecho

Enter the RTTY Mode from the Command Mode by clicking on the RTTY button  on the HF

toolbar.  This will place the KAM in RTTY operation at the baud rate specified by RBAUD
(default 45) and the display will show the RTTY Mode with baud and shift rate.

To enter RTTY at another baud rate, go to the RTTY menu and select the Baud menu.

To enter the ASCII Mode, the same procedure is followed as for RTTY operation, except that

the ASCBAUD setting specifies the default baud rate and you click on the ASCII button .

Now that you have entered the desired mode (let’s assume RTTY), we will walk through a
sample of RTTY operation.  The same procedures will apply to ASCII operation.  First, let’s see
how we can call CQ in RTTY.  Since we entered the RTTY Mode without any other parameters,
we are operating at 45 baud (the default and most commonly used) with a 170 Hz shift (again the
default and most commonly used).

Next, we must place our transmitter into the Transmit mode and enter the CQ message.  To do

this, click on the Transmit button , which places the transmitter in transmit mode.  Then we

would type:

RYRYRYRYRYRYRYRYRYRYRYRYRYRYRYRYRYRYRYRYRYRYRYRYRY
CQ CQ CQ DE N4GDO N4GDO N4GDO
CQ CQ CQ DE N4GDO N4GDO N4GDO
CQ CQ CQ DE N4GDO N4GDO N4GDO K K K

After we have typed this, we need to return to Receive mode, by clicking on the Receive button

.  When the transmitter turns off, we now tune the receiver, looking for a station answering
our CQ.  Tuning RTTY and ASCII signals is simplified by use of the LED barograph.  While
observing this indicator, tune for an alternate blinking of the end segments of the barograph.
Once the station is tuned in, the terminal will begin to display the characters being received.

When the other station indicates that it is our turn to transmit, we would again click on the

Transmit button  to begin transmitting.  The data we type will now be sent over the air to the

receiving station.

At this point we are ready to end the QSO.  We simply shut down the transmitter by clicking on

the Receive button .  The QSO is ended.

Perhaps you would prefer to just monitor RTTY transmissions, looking for someone else who
may be calling CQ.  After you have entered the RTTY Mode, simply start tuning (you are already
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in the Receive Mode).  Again tune the receiver slowly until you receive the alternate blinking
ends of the barograph-tuning indicator.  If you fail to obtain this indication, try selecting a
different shift.  If you still fail to obtain this indication using the standard shifts, the station may be
using non-standard tones which could be decoded by selecting MODEM SHIFT and using the
MARK and SPACE commands to set various tones until the tuning indicator gives the proper
indication.

Once you have the proper tuning indication, it is still possible that the signal may be at the wrong
baud rate or the signal may be inverted.  If the signal is at the incorrect speed (baud rate), you
may change your receive speed with the baud menu.  If you think the signal may be inverted, you
can invert the received signal by using the Invert option on the menu.  This directive is a toggle
type of operation — that is, the first time will invert the signal, and a second entry will return the
signal to normal.

Now let’s examine each of the commands relating to RTTY and ASCII operation to see the effect
each will have on these Modes.

AUTOCR will cause the KAM to insert a carriage return sequence after you have entered n
characters without pressing the Enter key on your keyboard.  The KAM will count all characters,
including FIGURES and LETTERS shift characters.  The default setting is 72.

AUTOLF ON causes the KAM to insert a line feed after every carriage return that is received
from the distant station.  If received RTTY or ASCII signals appear double-spaced on your
screen, you will want to turn this command OFF.

The AUTOSTRT command is useful if you wish to leave your station in the automatic mode, in
which you can receive messages from other stations, even when you are not present.  With
AUTOSTRT ON, a station can cause you to start receiving data by sending the Call Sign in your
MYAUTOST parameter (will accept up to 7 characters allowing for MARS Call Signs) prior to
sending his/her message to you.  The KAM will stop receiving when it receives NNNN from the
other station or when there is no signal present for approximately 30 seconds.

The CCITT or code command controls which RTTY character code will be used in the RTTY
Mode.  When this command is OFF (the default) the US RTTY code will be used.  When ON, the
European code (ITA2) will be used. These two codes differ only on four characters and the
differences are shown here:

US RTTY ITA2

BELL , (comma)
‘ (apostrophe) BELL
+ “
= ;

The CRADD command determines how many carriage returns will be transmitted when a <CR>
is received from the terminal.  A standard operating practice in RTTY is to send a
<CR><CR><LF> at the end of each line to allow the receiving station time to return the carriage
of the mechanical RTTY machine to the far left edge of the paper before sending the next
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character.  This can be accomplished by setting the CRADD command ON.  This causes the
KAM to send an extra <CR> after every <CR> transmitted.  This command applies to ASCII and
RTTY Modes of operation, as well as AMTOR.

The CRSUP command determines how many carriage returns will be sent to the terminal.  When
CRSUP is ON and more than one <CR> is received in a row, every other <CR> will be
suppressed.  For example if you receive the standard <CR><CR><LF>, only <CR><LF> will be
sent to the terminal.

The DIDDLE command will cause the KAM to send a special diddle character whenever you are
in the transmit Mode, and no data is being sent.  The default for the DIDDLE command is ON.
This is used to allow the receiving station to tune your signal prior to you sending data since it
causes both MARK and SPACE signals to be transmitted.  The DIDDLE character is the LTRS
shift in RTTY Mode and in ASCII, a NULL is sent as the DIDDLE character.

The FSKINV command (default OFF) will determine the polarity of the signals sent from the
KAM to the FSK input of your transceiver.  In the OFF state, a MARK is open collector (open
circuit) and a SPACE is ground (closed circuit). Since transceiver manufacturers have not
implemented a standard for FSK operation, it may be necessary to invert your transmitted signal
using this command.  You cannot invert the transmitted signal once you are in the RTTY or
ASCII Mode, but only by the use of this command prior to entering either of these Modes.  In
order to invert your transmitted signal using AFSK, you will need to use MODEM shift and set
your MARK and SPACE tones using the MARK and SPACE command.

If INVERT is OFF, the KAM will decode RTTY, ASCII, and AMTOR signals as sent (i.e. MARK
is decoded as MARK, and SPACE is decoded as SPACE).  Most RTTY on the HF bands is sent
in lower sideband, but if your radio is upper sideband only, you may want to set the INVERT
command ON.  The decoding of the MARK and SPACE signals may be inverted after you have
entered the RTTY, ASCII, or AMTOR Mode by using the invert directive.  (See FSKINV for
inverting signals that you are transmitting.)

The LCRTTY command can be used to send and receive lower case RTTY.  When LCRTTY is
ON, lower case characters may be sent and received in RTTY and AMTOR Modes of operation.
This is accomplished by using the RTTY NULL character as a special shift character.  This
method is also used in RTTY to send the Russian Cyrillic alphabet.  If USOS is ON, a received
SPACE will shift to lower case.  The distant station will only receive lower case characters if he
also has LCRTTY ON.

The LOWTONES command controls the MARK and SPACE frequencies when using the
standard shifts of 170, 425, or 850 Hz.  When ON, the European low tones are used, with
MARK being 1275 Hz and SPACE being the MARK frequency plus the selected shift.  When this
command is OFF, the standard RTTY tones are used: MARK is 2125 Hz and SPACE is the 2125
plus the selected shift.

LFADD determines if a line feed <LF> will be transmitted after each carriage return <CR>
received from the terminal.  If LFADD is ON, the sequence <CR><LF> will be transmitted when
a <CR> is received from the terminal.
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LFSUP determines if received line feeds will be sent to the terminal.  If LFSUP is OFF and you
receive <CR><LF>, only the <CR> will be sent to your terminal.

The RBAUD command sets the baud rate.

The USOS command (Un-Shift On Space) when ON will cause the KAM to switch from figures
to letters upon receiving a space character from the other end.  If LCRTTY is also on, a received
space will switch to lower case characters.

When XMITECHO is turned on, the KAM will echo the transmitted characters to your terminal at
the time they are actually being transmitted.  This can be useful for determining when your
transmit buffer is empty, and therefore you may return to receive Mode.

Miscellaneous Information

Typically, in RTTY and ASCII operation, speed of transmission is specified in baud rather than
words-per-minute.  A chart of the comparison between these two is provided below.

BAUD WPM

45 60
50 67
57 75
75 100
100 132
110 147
150 200
200 267
300 400

You may set any desired baud rate, in 1-baud increments, from 20 baud up to a maximum of 500
baud.  However, HF operation below 28 MHz is limited to 300 baud.

RTTY and ASCII signals are sent by transmitting two different tones called MARK and SPACE.
The difference between these two signal frequencies is referred to as the SHIFT.  Standard shifts
employed in amateur RTTY communication are 170 Hz, 425 Hz, and 850 Hz.  The KAM
supports all of these shifts as pre-programmed shifts, but also supports the selection of any
desired shift through the use of the SHIFT command.  If this is set to MODEM, the KAM will
generate the MARK and SPACE tones that are specified by the MARK and SPACE commands.
This would allow the use of non-standard shifts or non-standard frequency pairs if desired.

SELCAL

SELCAL is an acronym for Selective Call.  SELCAL is derived from your call sign.  As a general
rule your AMTOR SELCAL consists of the first letter in your call sign and the last three letters of
your call sign.  To change your SELCAL consult your Kantronics TNC Manual.



38  - PacTerm for Windows

PSK31 Information

PSK31 is a new mode developed by Peter Martinez, G3PLX, and is based on SLOWBPSK
introduced by SP9VRC.  PSK31 uses Phase Shift Keying (PSK) or patterns of polarity reversals
rather than the more traditional Frequency Shift Keying (FSK).  Data is sent at a rate of 31.25
baud to handle typed-in text easily.  If bandwidth is approximately equal to baud rate, bandwidth
can be set to 31 Hz and narrow CW filters used.  Information is coded in an alphabet that is similar
to Morse code, variable length coding.  This variable length coding was developed by analyzing
English language ASCII text files for the frequency of occurrence of each of the 128 ASCII
characters.  The ASCII characters were then matched to binary patterns, with the most frequently
occurring characters having the shortest binary patterns.  Each character is separated from
neighboring characters by two consecutive 0 bits.  No character can contain more than one
consecutive 0 bit.  Each character must begin and end with a 1.  More information on PSK31 can
be found on the Internet at http://www.psk31.com.

Audio input and output is handled by the computer’s sound card rather than a TNC.  Keying is
done using VOX, a separate keying circuit, or the keying circuit in a TNC.  The choice of how to
key PSK31 will depend on your equipment and personal preferences.  See the PSK31 Setup
section of this help file for information on keying alternatives for your setup.

PSK31 Setup

Your computer’s sound card, rather than the TNC, handles audio input and output.  You will need
to create a connection between the computer’s sound card and your radio, with perhaps an
isolation circuit to protect your equipment. Keying can be done using a VOX, a separate keying
circuit, or the keying circuit in a TNC.  Several alternatives are available for keying PSK31,
depending on your equipment and computer capabilities.  Listed below are some of these
alternatives, categorized by the type of TNC you have.  Even though PSK31 does not require a
TNC to operate, PacTerm for Windows requires a TNC for operation since it is primarily TNC
software.  Where an external keying circuit is specified, you can use a keyer such as a Rig Blaster,
home brew keyer, or other keyer.  More information on PSK31 in general can be found on the
Internet at http://www.psk31.com.

One Packet-only TNC

If you have a packet-only TNC that does not support the HF modes, such as a KPC-3 or 9612,
you can do the packet modes and PSK31.  You have two keying methods available.  Keying uses
the RTS line off the serial port the TNC is on or the RTS line on the computer’s serial port.

• Use the TNC’s serial port with an external keying circuit.

• Use a free serial port on the computer with an external keying circuit.

One Packet-only TNC with a Timewave DSP-599y or DSP-599zx



39 - PacTerm for Windows

If you also have a Timewave DSP-599y or DSP-599zx in addition to a packet-only TNC, you can
do PSK31 and DSP-599 RTTY with the DSP-599 in line, as well as the packet modes.  Three
keying options are available.

• Use the TNC’s serial port with an external keying circuit.

• Use a free serial port on the computer with an external keying circuit.

• Use the DSP-599 keying circuit.

One Multimode TNC

If you have a multimode TNC such as a KAM or KAM 98, you can do all of the HF modes plus
PSK31.  This also adds the option of using the TNC’s internal keying circuit in addition to using
the serial port for keying.

• Use the TNC’s internal keying circuit for keying.  No external keying circuit is needed.

• Use the TNC’s serial port with an external keying circuit.

• Use a free serial port on the computer with an external keying circuit.

One Multimode TNC with a Timewave DSP-599y or DSP-599zx

With the addition of a DSP-599y or DSP-599zx to a multimode TNC, you have four keying
options.

• Use the DSP-599 for keying PSK31.  No external keying circuit is needed.

• Use the TNC’s internal keying circuit for keying. No external keying circuit is needed.

• Use the TNC’s serial port with an external keying circuit.

• Use a free serial port on the computer with an external keying circuit.

Note that if you use DSP-599 RTTY with a multimode TNC, you will need to use the keying
circuit in the DSP-599 rather than the keying circuit in the TNC.  This only applies to DSP-599
RTTY, not the TNC’s RTTY.

Single port multimode TNC with a second TNC for packet or AGW Packet Engine

If you have a single port multimode TNC such as the KAM 98, you can use a second TNC for
packet only or AGW Packet Engine.  If the second TNC is AGW Packet Engine, another free
serial port on your computer will be needed for AGW Packet Engine keying.  PSK31 and AGW
Packet Engine cannot share the same serial port.  See the AGW Packet Engine Setup section of
this help file for more information on setting up AGW Packet Engine.  Keying for PSK31 can be
done by one of the following options.

• Use the multimode TNC’s internal keying circuit.  No external keying circuit is needed.

• Use an external keying circuit on the multimode TNC’s serial port.

• Use a free serial port on the computer with an external keying circuit.
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Single port multimode TNC with a second TNC for packet or AGW Packet Engine and a
Timewave DSP-599y or DSP-599zx

If you have a single port multimode TNC, a second TNC for packet only or AGW Packet Engine,
and a Timewave DSP-599y or DSP-599zx, you must have a minimum of three free serial ports on
your computer.  If you want to use the computer’s serial port for keying, you will need to have
four free serial ports on your computer. If the second TNC is AGW Packet Engine, a separate free
serial port on your computer will be needed for AGW Packet Engine keying.  PSK31 and AGW
Packet Engine cannot share the same serial port.  Also the DSP-599 cannot share a serial port with
AGW Packet Engine.  See the AGW Packet Engine Setup section of this help file for more
information on setting up AGW Packet Engine.  Keying for PSK31 can be done by one of the
following options.

• Use the DSP-599 for keying PSK31.  No external keying circuit is needed.

• Use the TNC’s internal keying circuit for keying. No external keying circuit is needed.

· Use the TNC’s serial port with an external keying circuit.

• Use a free serial port on the computer with an external keying circuit.

PSK31 Operation

PSK31, or Phase Shift Keying 31 Baud, is a new digital mode that uses your sound card to
produce audio input or output rather than your TNC.  In PacTerm for Windows, keying can be
done by an external keyer or the internal keyer in a multimode TNC.  See the PSK31 Setup section
of this help file for information on hardware setup options and requirements.

Once you have set up your system for PSK31, you are ready to start PSK31.  Simply press the 

button on the toolbar to start PSK31.  This will bring up the PSK31 Control Panel where you can
set your sessions controls and select a signal for your QSO.

AGW Packet Engine Information

AGW Packet Engine uses software and a computer’s sound card to send and receive AX-25
packets rather than using a traditional TNC.  AGW Packet Engine was written by SV2AGW.
PacTerm 98 version 1.5 and higher provides an interface to AGW Packet Engine.  See the AGW
Packet Engine Setup section of this help file for information on setting up AGW Packet Engine
and keying alternatives for your setup.  Additional information and support on AGW Packet
Engine is available on the SV2AGW’s web site at http://www.raag.org/sv2agw.
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AGW Packet Engine Setup

PacTerm for Windows works with AGW Packet Engine version 2000.76 and above.  Current
versions of AGW Packet Engine are available on the AGW Packet Engine web site at http://
www.raag.org/sv2agw.   In PacTerm for Windows, AGW Packet Engine would be used in place of
a second packet-only TNC.  The primary TNC should be a single port multimode TNC such as the
KAM 98 or other multimode TNC.  AGW Packet Engine does not allow you to choose a sound
card for your system.  If you have multiple sound cards, it will use the default sound card.  You
cannot use the same sound card for both PSK31 and AGW Packet Engine at the same time.  If you
have only one sound card, you will need to shut down AGW Packet Engine in order to run PSK31.
If you want to run AGW Packet Engine again, you will need to shut down and restart PacTerm for
Windows.

AGW Packet Engine requires that you have a free serial port on your computer and an external
keying circuit.  This serial port cannot be shared with other devices.  The serial port is selected in
the AGW Packet Engine setup rather than the PacTerm for Windows setup.  PSK31 and AGW
Packet Engine cannot share the same serial port.  PSK31 will need a separate serial port and
keying circuit if you plan to run both PSK31 and AGW Packet Engine.  The keying circuit can be a
keyer such as a Rig Blaster, home brew keyer, or other keyer.  If you also have a DSP-599 in
addition to a multimode TNC, the DSP-599 cannot share a serial port with AGW Packet Engine.
See the PSK31 Setup section of this help file for information on keying alternatives and setup
configurations for PSK31.

KAM 98

The KAM 98 may be used for HF packet, VHF packet or HF Non-Packet operation but not both
at the same time.  Featuring one radio port, it can be cabled to a SSB radio for HF operation, a
FM radio for VHF/UHF operation, or a combination SSB/FM transceiver, such as the ICOM-706.
In any of these cases, the modem within the KAM 98 must be programmed to accommodate either
HF or VHF packet.

Three hundred baud HF packet is operated in SSB mode and standard AFSK tone pairs are
generally used: Mark 2125, Space 2295.  These are the default tones set within the KAM 98.  To
switch to 1200 baud FM packet, the tone pairs – and other packet parameters – within the modem
must be changed.  This task is completed automatically for you when you click HF packet or VHF
packet as a mode of operation in the Communications Settings page under File/Settings.

For reference, these are the default values for HF and VHF packet operation that PacTerm for
Windows uses:

Parameter HF (default) VHF setting

hbaud 300 1200
mark 2125 1300
space 2295 2100
maxframe 1 4
paclen 64 128
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persist 192 63
slottime 5 10
SWP 17,17,50 7,17,108

There are a few differences between using PacTerm for Windows with the KAM 98 and using it
with other TNCs.

• If you are using a KAM 98 then when you first open PacTerm for Windows, neither VHF nor HF
view will be open.  Simply click on the file menu and choose whether you want HF or VHF View.

• As noted above, the KAM 98 uses one port for HF packet and VHF packet operation.  When
changing from one mode of operation to the other, you must open the Settings screen and click
on the Communications tab.  There you can choose either HF or VHF packet modes.

Call Bar, Macro bar and view tab

A few new Items have been added to PacTerm for Windows to make it more convenient and user
friendly.

The Call Bar is where you can enter call signs for connections without having to press F2 to bring
up the command prompt or F7 to bring up the Quick Connect screen.
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A Macro Bar has been added to PacTerm for Windows to automate using your Mode Macros,
calling CQ, and sending your ID and QRT. The CQ, ID, QRT, and Mode Macros are set under
File, HF Non-Packet Settings on the HF window.  To automatically call CQ, select the number of
times you wish to repeat your CQ call and the Interval between calls in seconds.   Then click the

CQ button  to transmit your CQ call.  You can also transmit your ID, QRT, or CWID once for

each button click by click the ID button , QRT button , or the CWID button . See the

CQ, ID and QRT Macros Settings section of this help file for more information on setting up this

feature.   The Mode Macro buttons M1 through M10 (for example,  ) allow easy access to

your Mode Macros that are specific to each mode.  See the Edit Macro Settings section of this
help file for more information on setting up Mode Macros.  To quickly stop sending a macro, click

the Stop button . When you are in RTTY Mode, you will also see a FIGS button  and a

LTRS button  on the toolbar.

The Window Tab allows you to easily switch between open windows in PacTerm for Windows.
Simply press the tab for the window that you wish to be moved to the front of the PacTerm
window.

Another addition to PacTerm for Windows is the PacTerm for Windows icon that is placed in the
system tray at the bottom right-hand of your screen.

Right Click Menu

There is a pop-up menu available in the text and chat windows by clicking your right mouse button
in the window.  You can also access the Copy command by clicking your right mouse button in the
command window or any of the port monitor windows.

This is the pop-up menu you get when you click the right mouse button in the VHF text window.

This is the pop-up menu you get when you click the right mouse button in the VHF chat window.
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This is the pop-up menu you get when you click the right mouse button in the HF Non-Packet text
window.

This is the pop-up Menu you will see when you click the right mouse button in the HF Non-Packet
chat window.

Copy Macro Variable

Copies the selected text to either the {name} or {call} macro variable.  To use this command,
select text and click your right mouse button on it to bring up the pop-up mean.  Select the “Copy
Macro Variable” menu item and the variable as shown below.

Log Contacts

This command allows you to send a contact to your Log Windows or DXBase 2002 database.  To
log a contact, highlight the call sign in the HF window, click the right mouse button, and select
“Log Contact to” from the pop-up menu and then select your choice of logging programs.
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After you pick the logging program, a window will appear, similar to the one below, which allows
you to complete and send the information to either DXBase 2002 or Log Windows.  For Log
Windows, you can also go ahead and save the information.
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PacTerm for Windows VHF Controls

VHF View

This is the PacTerm for Windows VHF window.

Window Menu

Cascade - Use this command to arrange multiple opened windows in an overlapped fashion.

Tile – Use this command to arrange multiple opened windows in a non-overlapped fashion.

Arrange Icons - Use this command to arrange the icons for minimized windows at the bottom of
the main window.
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Help Menu

Help Topics - PacTerm for Windows Help is your online help.

Window Help – This is your Window 95/98/ME Help.

Register Software – Use this to register your software.

About PacTerm for Windows – Shows to whom the software is registered and what hardware
and firmware is used.

Quick Connect

Quick Connect allows you to store frequently used connections.  To create a Quick Connect,
select the Options menu and then select Add Quick Connect.  To edit a previous entry, select Edit
Quick Connect.  To delete a previous entry, select Delete Quick Connect.
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VHF File Menu

VHF File Menu

New VHF Session - This command opens a new unconnected VHF stream in a new window on
Radio Port 1.

New Port 2 Session - This command opens a new unconnected session on Packet Radio Port 2.

New HF Non Packet Session - This command opens a window that allows you to use non-packet
HF modes, if allowed by your TNC.

Open File - Use this command to open an existing document.

View ANSI file - ANSI – American National Standard Institute.  ANSI is an 8-bit character set of
256 characters.  You can view or save an ANSI file with this command.

Close – Use this command to close the active session.

Save – Use this command to save the active session to its current name and directory.

Save As – Use this command to save and name the active session.

Settings - This command provides options to select which callbook you are using, to select the
drive associated with your CD-ROM, to change your port settings and baud rate, to create
macros, and to create startup and shutdown commands.

Print – Use this command to print a session.

Print Preview – Allows you to preview a page before printing.

Print Setup – Allows you to set different parameters for printing.
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Exit - The Exit command exits from the program

VHF Session Command

The New VHF Session command opens a new unconnected VHF stream in a new window on
Radio Port 1.  This is for VHF Packet sessions only.  Select the “New VHF Session” option in the
File menu.

Port 2 Session Command

The New Port 2 session command opens a new session on Packet Radio Port 2.  This is only for
VHF and HF Packet session, depending on your TNC.  Select the “New Port 2 Session” option
in the File menu.

HF Session Command

The New HF Non-Packet Session command opens a window that allows you to use non-packet
HF Modes, if allowed by your TNC.  Select the “New HF Session” from the File menu.

View ANSI File

ANSI – American National Standard Institute.  ANSI is an 8-bit character set of 256 characters.

To view an ANSI file:

1) Select View ANSI File from the File menu.

2) This brings up the screen shown below.

3) Select the folder where the file you want to view is located.

4) Select the file you want to view and click Open.

5) The ANSI file will be displayed in the window.
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Settings Command

The settings option brings up the settings dialog box.  This allows you to select which type of CD
CallBook you are using and designate the drive associated with your CD-ROM.  It also allows
you to change your Port settings and baud rate, create macros, and create and edit startup and
shutdown commands.

CallBook Settings
Communications Settings
Edit Macros
Startup/Shutdown Commands
Edit Call Sign Exchange
Optional Settings
User Defined Macro Variables
Packet Parameters
Packet Switches
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CallBook Settings

A CallBook is a Database of amateur radio call signs.  The following dialog box allows you to
select which CD CallBook you use.  Options include QRZ, BuckMaster, RAC, SAM, or none.  It
also allows you to set the drive letter that corresponds to your CD-ROM or a path if you store
your Radio Amateur CallBook on your hard disk.  “Path for…” is only enabled when “Radio
Amateur Callbook (all)” is selected.  PacTerm for Windows includes a mini contact database so
even if you don’t have a CallBook, you can keep track of your contacts.

Communications Settings

This allows you to set the COM port to which your TNC is connected, and the baud rate used
when communicating with the TNC.  PacTerm for Windows supports COM1 through COM35.
Make sure your TNC is properly connected to the selected COM port and make sure you select
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the same baud rate that is set in the TNC.  (The baud rate selected should be set to the same as the
current TNC baud rate if it had been used before with another program.)  Put a check mark beside
“Use Two TNCs” if you plan to use a second TNC for Packet only.  If you plan to use AGW
Packet Engine as your second, packet-only TNC, put a check mark beside “Use AGW Packet
Engine” and select a COM port and Baud rate for AGW Packet Engine.

Edit Call Sign Exchange

This box allows you to edit your call sign and the other station’s call sign to be used with the Call
Exchange hot key.  You can enter the other station’s call sign during a contact by highlighting the
call sign in the chat window and selecting “Copy to Call Exchange” from the right mouse click
menu.  The call sign will be entered for you into this screen.
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Edit Macros Settings

A Macro is user-defined text that is associated with a particular keystroke.  This dialog box
allows you to create custom macros.  There are 10 global macros for VHF, 10 global macros for
HF, and 10 specific macros for each of the HF modes.

To set up a macro, select a macro number.  Enter a name for the macro in “Macro Name” and
then enter the information in the macro text box.  (You can use <Ctrl-Enter> to insert a carriage
return into the macro text).  You can create a macro using the user-defined macro variables as
shown in the picture below.  The name you specify for the new macro will show up in the macro
menu.
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Macro Variables

These variables can be used in the macros that you create in the Edit Macros Settings.  The macros
can be created using variable names and when these variables change, the macro changes
automatically.

{call} – This is the call sign of the person to whom you are talking.
{name} – This is the name of the person to whom you are talking.
{mycall} – This is your call sign.
{myname} – This is your name.
{selcal} –  This is your SELCAL.
{qth} – This is your location.
{sn} – This is the starting number for the sequential serial number.
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There are also five macro variables you can use that are not listed.

{date} – Sends the current date from your system clock.
{time} – Sends the current time from your system clock.
{utctime} – Sends the current Greenwich Mean Time from your system clock.
{xmitvhf} – Putting this variable at the end of a VHF macro will allow the macro to be transmitted
without pressing <Enter> (Can be used in VHF macros only)
{xmit} – Turns the transmitter on. (Can be used in HF macros only)
{rec} – Turns the transmitter off.  (Can be used in HF macros only)

Starting with version 1.3 of PacTerm for Windows, another Macro variable is available.  The {sn}
macro variable is used as a serial number for contests.  You can use this new macro variable to
keep track of the number of contacts you would use.  For example you could set up a macro in the
‘Edit Macros’ tab of the settings screen and you could put in there:

This is {mycall} from {qth} you are contact number {sn}

This macro would read as:

This is N4GDO from Florence, AL you are contact number 1.
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With the {sn} macro, PacTerm for Windows will remember the number of times you ran the macro
and will increment the number displayed by 1 each time.  PacTerm for Windows will remember the
number that was last used even when you close down the program, so you can take a break from
the contest to eat.  When you come back the number will be the same as when you left.  To restore
the number back to zero at the end of the contest or at the beginning of a new one simply go to the
‘user defined macro variables’ tab in the settings window and change the number in the {sn} field
to 0.  If you would rather update {sn} manually rather than automatically, put a check mark beside
“Manually update S/N”.  This will bring up the following dialog box whenever you use a macro
containing {sn}.
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Checking the “Append zeros to S/N” box, will add zeros to the beginning of the serial number.
For example, serial number 1 would appear as 001.

For example, assume the settings were filled in with these values:

{call} – KF4WGU
{name} – Sydney
{mycall} – N4GDO
{myname} – ricker
{selcal} – ngdo
{qth} – Florence, AL

You could set up a macro like this:

{call} DE {mycall} Hi there {name}, My name is {myname}, and my QTH is {qth}.  My
Selcal is {selcal}.  The current time is {time} and the current date is {date}.

When the macro is invoked, it would type this to the screen:

KF4WGU de N4GDO Hi there Sydney, My name is ricker, and my
QTH is Florence, AL.  My Selcal is ngdo.  The current time is
09:33:41 and the current date is Wednesday, June 17, 1998.

Optional Settings

MAXUSERS on startup

This section allows you to set the maximum number of users on startup.  The MAXUSERS
command causes the TNC to allocate the memory required for the maximum number of
simultaneous connections you wish to allow.  Each connection uses a different stream.  You will
see an option to change MAXUSERS on each port that you have available on your TNC.  The
highest each port can be set is 26.

Sounds

The Sound ID on Connect option allows you to turn sounds on or off.  If you choose sounds to be
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on, you can use the sounds that are included or choose your own.

HF Transmit Mode

For information on the HF Transmit Mode, see the Changing HF Send Option section of this help
file.

To set the sounds, click on each item and enter the filename of the sound to associate with it.
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Startup/Shutdown Commands

The dialog box shown is where you can enter your own startup and shutdown commands.  These
commands are sent to your TNC during startup and shutdown.  Note:  You must put a carriage
return after your commands.
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Packet Parameters

This option automates setting your TNC’s packet parameters.   Clicking the “Default Parameters”
button resets these parameters to their default settings.  Check your TNC manual for the default
settings for these parameters and usage of these parameters.
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Packet Switches

This option automates switching your TNC’s packet parameters off or on.  Clicking the “Default
Parameters” button resets these parameters to their default settings.  Check your TNC manual for
the default settings for these parameters and usage of these parameters.
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VHF Edit Menu

VHF Edit Menu Options
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Cut - Use this command to remove the currently selected data from the session and put it on the
clipboard

Copy - Use this command to copy selected data onto the clipboard.

Paste - Use this command to insert a copy of the clipboard contents at the insertion point.

Clear Screen - Clears the text from the active text window.

Repeat Last Text - Repeats the last text you sent.  The text will be put into the active chat
window.

Copy To Call Exchange – Allows you to copy your contact’s call sign into the call exchange
buffer.

Call Exchange  - Takes the call sign you have copied with the Copy to Call Exchange and
appends it to the information that was created in the settings for Call Exchange.

Clear Screen

Clears the text from the active text window.

Repeat Last Text

Repeats the last text you sent.  The text will be put into the active chat window.

Copy to Call Exchange

Copy to Call Exchange allows you to copy the call sign you are communicating with into call
exchange buffer, and then use it by clicking on Call Exchange.

To Copy a Call Sign, you need to highlight it and then select the Copy to Call Exchange option
from the Edit menu or click your right mouse button on the highlighted call sign and choose
Copy to Call Exchange from the pop-up menu.

Call Exchange

Call Exchange takes the call sign you have copied with the Copy to Call Exchange and sends it to
the chat window along with your previously stored call sign.  Call Exchange settings are accessed
by clicking on File, Settings, and the Edit Call Sign Exchange tab.

To use the call sign in your Call Exchange, select Call Exchange from the Edit menu or click your
right mouse button and choose the Call Exchange from the pop-up menu.
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VHF View Menu

VHF View Menu Options

Toolbar - Use this command to display and hide the Toolbar.

Status Bar – Use this command to display and hide the Status Bar.

Monitor Port 1 – Use this command to display and hide the Monitor Port 1 Window.

Monitor Port 2 - Use this command to display and hide the Monitor Port 2 Window.

Commands Window - Use this command to display and hide the Command window.  (Check
mark indicates it is displayed)

Toolbar Command

Use this command to display and hide the Toolbar, which includes buttons for some of the most
common commands in PacTerm for Windows, such as File Open.  A check mark appears next to
the menu item when the Toolbar is displayed.

See Toolbar for help on using the toolbar.

Status Bar Command

Use this command to display and hide the Status Bar.  The Status Bar displays the action to be
executed by a selected menu item or depressed toolbar button, and keyboard latch state.  A check
mark appears next to the menu item when the Status Bar is displayed.

See Status Bar for help on using the status bar.
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Monitor/Unproto 1 Window

This is where network traffic for Radio Port 1 is viewed.

Monitor/Unproto 2 Window

This is where network traffic for Radio Port 2 is viewed.

Command Window

This is where the commands you send to the TNC and the return value of the commands from the
TNC are viewed.  Commands to the TNC can be entered at the “cmd:’ prompt
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Minimize All Windows When Main Window is Minimized

When this item is checked, the Command window and Monitor windows are minimized or
maximized when the larger PacTerm for Windows window is minimized or maximized.

VHF TNC Menu

VHF TNC Menu Options

Connect – This command brings up the Connect window.

Disconnect  - This command disconnects the active window from your contact’s station.

Commands – Sends program defined commands to the TNC.

Abort Connect – Aborts a Quick Connect.

Connect Command

There are three ways to connect to a station:

1) Press F2.  This puts you in command mode.  At the cmd: prompt, type  “c Call Sign”,
replacing “Call Sign” with the call sign of the station, and press <Enter>.

2) Press F7 or select the Connect command in the TNC menu to bring up the Connect to Station
dialog box.  To use Connect you must enter the call sign of your contact and then click the
Connect button.

3) You can also create a Quick Connect to the stations you most use.  This allows you to click
on the station rather enter them every time you want to connect to it.  To create this shortcut
you must select add from the Options menu.
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Disconnect Command

The Disconnect Command disconnects the active window from the currently connected station.
There are three ways to disconnect from a station:

4) Press F2 and type “d” at the cmd: command prompt (Without the quotes).

5) Press <Shift-Alt-F7>.

6) Select Disconnect from the TNC menu.

Hotkey:  <Shift-Alt-F7>

Mheard Command

Selecting the Mheard Command returns a list of the stations heard by the TNC.  The stations heard
response will appear in the Command window.

Status Command

Selecting the Status command will display the following information in the Command window: the
number of bytes available in the TNC buffer, the current I/O stream, and any streams having
connected status command.  Results of these commands will be in the Command window.

Version Command

The Version command causes the TNC to display the current version number in the Command
window.

Send Control A

Some bulletin boards and clusters use the <Ctrl-A> sequence for text editing.  The <Ctrl-A>
command is similar to the standard Windows commands so we use the <Shift-Ctrl-A>
keystrokes instead.

Hotkey:  <Shift-Ctrl-A>.



69 - PacTerm for Windows

Send Control T

Some bulletin boards and clusters use the <Ctrl-T> sequence for text editing.  The <Ctrl-T>
command is similar to the standard Windows commands so we use the <Shift-Ctrl-T>
keystrokes instead.

Hotkey:   <Shift-Ctrl-T>.

Send Control Y

Some bulletin boards and clusters use the <Ctrl-Y> sequence for text editing.  The <Ctrl-Y>
command is similar to the standard Windows commands so we use the <Shift-Ctrl-Y>
keystrokes instead.

Hotkey:   <Shift-Ctrl-Y>.

Send Control Z

Some bulletin boards and clusters use the <Ctrl-Z> sequence for text editing.  The <Ctrl-Z>
command is similar to the standard Windows commands so we use the <Shift-Ctrl-Z> keystrokes
instead.

Hotkey:  <Shift-Ctrl-Z>.

Send Command

The Send command brings up a Send Command dialog box.  This allows the user to enter a TNC
command.  The results of these commands will be in the Command window.

Abort Connect

When using a VHF Quick Connect, this button will abort the Quick Connect.  This will not work
when you use the regular Connect option.
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VHF Mode Menu

VHF Mode Menu Options

Host - Host Mode operation provides a standardized method of communication between the
Kantronics TNC and PacTerm for Windows.

Terminal – Terminal Mode operation is a communication mode with the TNC similar to that of a
standard (not Host Mode) terminal program.

Return to Terminal Mode on Exit – Allows you to exit Host Mode and return to Terminal Mode
when the program is closed.

Unproto Mode - Unproto Mode operation allows packets to be transmitted without being
connected to a station.

Bring up HF window when starting program - Allows you to set PacTerm for Windows to
bring up the HF non-session window when the program starts, allowing people who don’t use the
HF modes to not be bothered by the HF window popping up when they start the program.

Sync with Log Windows – Allows PacTerm for Windows to sync with Log Windows™.  Both
Log Windows and PacTerm for Windows must be running to use this command.

Sync with Dx4Win – Allows PacTerm for Windows to sync with Dx4Win™.  Both Dx4Win and
PacTerm for Windows must be running to use this command.

Host Mode

Host Mode operation is the normal communications mode between a Kantronics TNC and
PacTerm for Windows.  It allows for multi-port, multi-stream and non-packet modes in separate
windows, at the same time (when using a KAM).

Terminal Mode

Terminal Mode operation is a communication mode with the TNC similar to that of the Windows
terminal program, HyperTerminal.  All terminal mode functions are at the TNC level with the
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software acting as a “Dumb” terminal.

Return to Terminal Mode on Exit

When selected, the TNC will be returned to terminal mode, when exiting the program.  You may
want to select this choice if you use other programs to operate the TNC, when you are not using
PacTerm for Windows.

Unproto Mode

Unproto Mode operation allows packets to be transmitted without being connected to a station.
This packet is not directed to a specific station, therefore no acknowledge is expected and no
retries are attempted.  This mode is often used for calling CQ and for informal round table chats.
This can be used with either Host or Terminal Mode.

Format Menu

Format Menu Options

Font - The Font command allows the user to select the type, style and the size of the font used to
display text in the window.

Color – In the Text Box, the Color command allows the user to select the colors of the text, the
transmitted text, the command text, and the background.  In the Chat Box, the user can change the
color of the chat text and the background.

Font Command

The Font command allows the user to select the type, style, and the size of the font used to
display text.
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Color Command

The Color command allows the user to select the color of the text and background for the text
box, the chat box, the transmitted text color, and the commands text color.
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Selecting any of the four-color boxes brings up the following Color Chart.  By selecting the
Define Custom Colors, you are able to choose from common colors for background or you can
define new colors to use.

VHF File Transfer Menu

VHF File Transfer Menu Options

Send YAPP - Sends a file using the binary transfer protocol called YAPP.

Receive YAPP – Receives a file using the binary transfer protocol called YAPP.

Send ASCII - Sends an ASCII file with no protocol.

Stop Transfer - Stops any file transfer (YAPP or ASCII).
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Send YAPP

Sends a file using the binary transfer protocol called YAPP.  Send YAPP allows you to transfer a
file (text, binary, picture, etc.) from your computer to another station.

To send a file with YAPP Upload, first make sure you are in the session window of the station to
which you want to send a file.  If you are connected to a BBS, you will want to tell the BBS that
you are doing a YAPP upload before you start your transfer.  After the other station is ready to
receive, pick the Send YAPP option from the File Transfer menu.  A file dialog box will be
presented to you.  Now you can pick the file name for the transferred file or cancel the transfer.

After you pick the file, the YAPP upload will begin.  Note that all the file transfer information is
updated on the Status Bar for the current session.  This will let you know the progress of your
file transfer.  You can also continue to chat with the other station while the transfer takes place.

After the transfer is done, the Status Bar will be updated.

To abort a transfer, select the ‘Stop Transfer’ option from the menu or click the Stop button 

on the toolbar.

Receive YAPP

Receives a file using the binary transfer protocol called YAPP.

Receive YAPP allows you to receive a file (text, binary, picture, etc.) from another station using
the YAPP Download transfer protocol.

To receive a file, first make sure you are in the session window of the station sending the file.  If
you are connected to a BBS, you will want to tell the BBS that you are doing a YAPP download
before you start your transfer.  After the other station is ready to send, pick the Receive YAPP
option on the menu.  A file dialog box will be presented to you.  Now you can pick the file name
for the transferred file or cancel the transfer.

After you pick the file, the YAPP download will begin.  Note that all the file transfer information
is updated on the Status Bar for the current session.  This will let you know the progress of your
file transfer.  You can also continue to chat with the other station while the transfer takes place.

When the transfer is finished, the Status Bar will be updated.

To abort a transfer, select  ‘Stop Transfer’ from the menu or click on the Stop button  on the

toolbar.
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Send ASCII

Sends an ASCII text file with no protocol. This option allows you to upload ASCII files while
connected to another station.  To send an ASCII file with this option, you will be presented with
a dialog box asking you for the filename.  Chose the filename and click the OK button.  The file

will then be transferred.  To abort the transfer, click on the Stop button  or choose the ‘Stop

Transfer’ menu option.

Stop Transfer

Stops any file transfer (YAPP or ASCII).  When the Stop button  is clicked any remaining text

or data that has not been sent to the TNC is terminated.  You may see some text on the screen
after the transfer is aborted.  This is normal due to emptying of the buffer.

LookUp Menu

LookUp Menu Options

Call Sign - Allows the user to look up a particular call sign.

Call Sign LookUp Command

The Call Sign LookUp command allows the user to look up a particular call sign.  You enter the
call sign and then it looks it up on the CallBook that is specified in the Setting section to see
whom it belongs to and then it displays the information.  Before the information is returned from
the CD CallBook, you can enter or modify the contact information for that station in PacTerm’s
contact database.
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Macros Menu

Macros Menu Options

Macro - User-defined text that is associated with a particular keystroke.  There are 10 global
macros for VHF, 10 global macros for HF and 10 mode-specific macros for HF.  To create a
macro, select the Settings option from the File menu and then select the Edit Macros tab.  This will
give you the Edit Macro Settings page.  Pick a name for the macro and then enter the information
in the macro text window.

Macros

Macros are messages that the user is able to define and assign to a keystroke.  You can create up
to ten different global macros in both Packet and Non-Packet HF Modes.  You can also create up
to ten different macros for each of the HF modes.
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PacTerm for Windows HF Controls

HF View

This is the PacTerm for Windows HF window.

Link to a Station

To link to another station, you need to click the Link button .  Link will bring up a connect

box and you need to enter the SELCAL of your contact.

Sending to Receiving Data

The station that initiates the link starts as the information sending station (ISS) .  The station

receiving a link request starts as the information receiving station (IRS) .

As ISS you may send information by typing text in the chat window which is immediately below
the text window and above the status bar.  Once you have finished typing what you wish, you can
press the IRS button to change the information direction.  Once you have done that, the link will
sound different and your status bar will reflect your station as IRS.
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Disconnect from a Station

To disconnect from a station, click on the Disconnect button .

Changing HF send option

A handy feature in PacTerm for Windows is the HF Data Transmit Mode.  With this new option
you can choose one of many ways to send your HF communications.  The new settings are (1)
Character mode (2) Word Mode or (3) Line Mode.

Character Mode: With this setting selected simply the PacTerm for Windows will transfer data
after each character is entered.  For example: if you are typing in CQ CQ CQ DE  N4GDO K,
then PacTerm for Windows would transmit as follows:

 (T)=transmit Data to TNC

C(T) Q(T) C(T) Q(T) C(T) Q(T)  D(T) E(T) N(T) 4(T) G(T) D(T)
O(T) K(T)

Word Mode: If you select this option then PacTerm for Windows will transmit after every word
or every time you press the <Space> bar or the <Enter> key.  Press the <Ctrl-Enter> key
combination to enter a carriage return without transmitting the data to the TNC.  An example of
this mode would be if you were sending CQ CQ CQ DE N4GDO K, then it would be transmitted
as follows.

(T)=Transmitted data to TNC

CQ(T) CQ(T) CQ(T) DE(T) N4GDO(T) K(T)

Line Mode: When you select this option, PacTerm for Windows will transmit to the TNC every
time you hit a carriage return (i.e. the <Enter> key).  This allows you to wait until you have typed
in everything you wish to send before PacTerm for Windows sends the data in one big burst.  Press
the <Ctrl-Enter> key combination to enter a carriage return without transmitting the data to the
TNC. Using the same example as above, the data would be transmitted as follows:

 (T)=Transmitted data to TNC

CQ CQ CQ DE N4GDO K. (T)

In order to take advantage of these new features simply go to the PacTerm window and click
Settings on the File Menu.
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After the Settings window appears on your screen, simply choose the Optional Settings tab at the
top of the Settings window and you will see the following window.

When this screen appears, simply choose the one of the modes found in the lower right portion of
the window.
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HF File Menu

HF File Menu Options

Open File - Use this command to open an existing document, by selecting a document name.

Close - Use this command to close the active session.

Save – Use this command to save the active session to its current name and directory.

Save As – Use this command to save and enter different name for the active session.

HF Non Packet Settings – Allows you to specify settings for the HF Non Packet Modes.

Print – Use this command to print a document.

Print Setup – Allows you to set different parameters for printing.

Exit – The Exit command exits and closes from the HF window.

HF Non Packet Settings

Below is a list of the options available in the HF Non-Packet Settings.

ASCII Settings
CW Settings
RTTY Settings
NAVTEX Settings
AMTOR Settings
PACTOR Settings
GTOR Settings
User Defined Macro Variables
PSK31 Options
CQ, ID and QRT Macros
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Edit Macros
Edit Callsign Exchange
KAM XL PSK-31 Options

AMTOR Settings

MYSEL4 or MYSEL7 – The SELCAL specified by this command will be used for your station
identification.  See the Creating a Unique SELCAL from an Amateur Call Sign  to create your
SELCAL

MYGROUP4 or MYGROUP7– This is used to set the SELCAL that can be used for reception
of SELFEC transmissions.

Insert <CR> - Inserts a carriage return after a user defined number or characters.

ARQ Link Timeout – This command sets the timeout interval when attempting to link to another
station.

WRU - Who Are You text - This is personal information about yourself.

Invert Tones - Signals received in RTTY, ASCII, or AMTOR, and signals transmitted using AFSK
are inverted.

Shift – This option sets the default shift used.  When MODEM is selected, MARK and SPACE
commands set the frequencies used by HF MODEM in the TNC.

Mark – This command sets the MARK frequency when the SHIFT command is set to MODEM.
The MARK command must be less than the SPACE command.

Space – This command sets the SPACE frequency when the SHIFT command is set to MODEM.
The SPACE command must be greater than the MARK command.
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ASCII Settings

Auto Start Call Sign – This command specifies the call sign used for automatically starting
receive operation in ASCII when the AUTOSTRT command is ON.  The call sign may be up to
seven characters long, allowing for MARS call aigns.

Receive Auto Start – When this is checked, it will receive information only after it has received
the MYAUTOST Identifier.  It will continue to receive until it receives four “N’s” signifying the
end of the message, or 30 seconds of no signal.

Diddle Character – When this is checked, a diddle character is sent when no characters are
available from the keyboard or buffer during transmission.
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Invert Tones - Signals received in RTTY, ASCII, or AMTOR, and signals transmitted using AFSK
are inverted.

Shift – This option sets the default shift used.  When MODEM is selected, MARK and SPACE
commands set the frequencies used by HF MODEM in the TNC.

Mark – This command sets the MARK frequency when the SHIFT command is set to MODEM.
The MARK command must be less than the SPACE command.

Space – This command sets the SPACE frequency when the SHIFT command is set to MODEM.
The SPACE command must be greater than the MARK command.
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CW Settings

CW Speed - This command sets the CW speed used when entering the CW Mode.

CW Tone – This command sets the center frequency of the CW filter.

CW Bandwidth – This sets the audio bandwidth for CW operation.

GTOR Settings

Call Sign for GTOR – Your call sign.

Fuzzy bits – Sets the number of bits in a data acknowledgment that may be corrupted.
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Timeout - Sets the timeout attempts.

Speed Up – Sets the maximum number of attempts to speed up.  If unsuccessful after n attempts,
will return to previous speed.

GTOR Up - Sets number of consecutive good frames received before switching to 300-baud
operation.

GTOR Down – Sets the number of consecutive bad frames received before switching to the next
lower level.

Insert <CR> - Inserts a carriage return after so many characters

Shift – This option sets the default shift used.  When MODEM is selected, MARK and SPACE
commands set the frequencies used by HF MODEM in the TNC.

Mark – This command sets the MARK frequency when the SHIFT command is set to MODEM.
The MARK command must be less than the SPACE command.

Space – This command sets the SPACE frequency when the SHIFT command is set to MODEM.
The SPACE command must be greater than the MARK command.
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PACTOR Settings

Call Sign for PACTOR Link – Your call sign

Unproto Speed – Speed of non-connected transmissions.

Timeout Attempts- Sets the number of timeout attempts.

Number of Repeat unproto - Number of times information is transmitted.

Shift – This option sets the default shift used.  When MODEM is selected, MARK and SPACE
commands set the frequencies used by HF MODEM in the TNC.

Mark – This command sets the MARK frequency when the SHIFT command is set to MODEM.
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The MARK command must be less than the SPACE command.

Space – This command sets the SPACE frequency when the SHIFT command is set to MODEM.
The SPACE command must be greater than the MARK command.

RTTY Settings

Unshift On Space – When this option is checked, an unshift to letters can occur when a space is
received.

Receive Auto Start – When this is checked it will receive information only after it has received the
MYAUTOST identifier.  It will continue to receive until it receives four “N”s, signifying the end of
the message, or 30 seconds with no signal.
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Diddle Character – When this is checked a diddle character is sent when no characters are
available from the keyboard or buffer during transmission.

Add CR to sent CR – Adds an extra Carriage Return when a Carriage Return is sent

Add LF to sent CR – Adds an extra Line Feed when a Carriage Return is sent.

MARS display – Translates LTRS characters to <Ctrl-O> and FIGS characters to <Ctrl-N> and
sends these to the terminal.

Wideshift – RTTY tones are shifted 1000 Hz.

Invert Tones - Signals received in RTTY, ASCII, or AMTOR, and signals transmitted using AFSK
are inverted.

European RTTY Tones - Check here to use the European RTTY code.

European Low Tones  – To use the European MARK and SPACE frequencies, check this Auto
Start – When this is checked it will receive information only after it has received the MYAUTOST
identifier.  It will continue to receive until it receives four “N’s”, signifying the end of the message,
or 30 seconds with no signal.  Shift - This option sets the default shift used.  When MODEM is
selected MARK and SPACE commands set the frequencies used by adjusting the switch
capacitance filters.

Invert RX Tones – Switches the MARK and SPACE tones.  This might be used, for example,
when you are on LSB and the other station is on USB.

Filter – When enabled, this inhibits printing of control characters that may be present in monitored
packets.

Usos – Sets RTTY “unshift on space” so that received characters are changed to LETTERS or
lower case condition after any “space” character is received.

Enable Xmit Functions – Allows the transmitter PTT line to be keyed.

Code – This is used to specify a character set for received text when you want to view text in a
character set other than International.

Auto Start Call Sign – This command specifies the call sign used for automatically starting
receive operation in RTTY when the AUTOSTRT command is ON.  The call sign may be up to
seven characters long, allowing for MARS call signs.

Shift – This option sets the default shift used.  When MODEM is selected, MARK and SPACE
commands set the frequencies used by HF MODEM in the TNC.

Mark – This command sets the MARK frequency when the SHIFT command is set to MODEM.
The MARK command must be less than the SPACE command.

Space – This command sets the SPACE frequency when the SHIFT command is set to MODEM.
The SPACE command must be greater than the MARK command.

Insert <CR> - Inserts a carriage return after so many characters
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NAVTEX Settings

Shift – This option sets the default shift used.  When MODEM is selected, MARK and SPACE
commands set the frequencies used by HF MODEM in the TNC.

Mark – This command sets the MARK frequency when the SHIFT command is set to MODEM.
The MARK command must be less than the SPACE command.

Space – This command sets the SPACE frequency when the SHIFT command is set to MODEM.
The SPACE command must be greater than the MARK command.

NAVTEX Originating Stations – This command specifies which originating stations will be
copied in the NAVTEX Mode.
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NAVTEX Message Classes – This command specifies which classes of NAVTEX messages will
be sent to the attached terminal.

HF Edit Call Sign Exchange

This window allows you to edit your call sign and the other station’s call sign to be used with the
Call Exchange hot key.
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PSK31 Options

Keying – Choose the appropriate option for the method you will be using to key PSK31.  If you
choose to use an external keyer on a separate serial port, you must also choose the COM port
where the keyer is attached.

Squelch Speed – This is a user selectable response speed.  If the signal value exceeds the
threshold specified, PSK31 characters will be decoded.  Under good signal conditions, a fast
response may be best.  Under noisy signal conditions, you may need to select a slower response.
Larger values will give a slower response speed.

AFC Limit – An AFC Limit can be selected from 0 to 1000 Hz. The PSK center frequency is
restricted to plus or minus the AFC limit in Hz.
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Sound Card Clock Adjust – This option is used to compensate for sound cards that are off
frequency.  Increasing the Sound Card Clock Adjust makes the sound card clock faster.
Decreasing it will make the sound card clock slower.

Sound Card Devices – Select whether you want to use your preferred or default sound card
device.  If you have more than one sound card, you can select which sound card device you want
to use.

CQ, ID and QRT Macros

Macro – This is where you type in the macro that will be executed when the CQ, ID or QRT
buttons are pressed.
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CQ – Text to be sent when you call CQ.

ID – Your call sign and other identification you may want to send.

QRT – Your sign off text

HF Edit Macros

A Macro is a user-defined text that is associated with a particular keystroke.  This dialog box
allows you to create macros.  There are 10 global macros for VHF, 10 global macros for HF, and
10 mode-specific macros for each HF mode.  Pick a name for the macro and then enter the
information in the macro text window.  (You can use <Ctrl-Enter> to insert a carriage return
into the macro text).  You can create a macro using the user-defined macro variables as shown in



95 - PacTerm for Windows

the picture below.  The name you specify for the new macro will show up in the Macro menu.

HF User Defined Macro Variables

These variables can be used in the macros that you create in the Edit Macros Settings.  The macros
can be created using variable names and when these variables change, the macro changes
automatically

{call} - This is the call sign of the person to whom you are talking.

{name} - This is the name of the person to whom you are talking.

{mycall} - This is your call sign.
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{myname} - This is your name.

{selcal} -  This is your SELCAL.

{qth} - This is your location.

{sn} - This is the starting number for the sequential serial number.

There are also five macro variables you can use that are not listed.

{date} - Sends the current date from your system clock.

{time} - Sends the current time from your system clock.

{utctime} - Sends the current Greenwich Mean Time from your system clock.

{xmitvhf} - Putting this variable at the end of a VHF macro will allow the macro to be transmitted
without pressing <Enter> (Can be used in VHF macros only)

{xmit} - Turns the transmitter on. (Can be used in HF macros only)

{rec} - Turns the transmitter off.  (Can be used in HF macros only)
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Starting with version 1.3 of PacTerm for Windows, another macro variable is available.  {sn} is
used as a serial number for contests.  You can use this new macro variable to keep track of the
number of contacts you would use.  For example you could set up a macro in the ‘Edit Macros’
tab of the settings screen and you could put in there:

This is {mycall} from {qth} you are contact number {sn}

This macro would read as:

This is N4GDO from Florence, AL you are contact number 1.

With the {sn} macro, PacTerm for Windows will remember the number of times you ran the macro
and will increment the number displayed by 1 each time.  PacTerm for Windows will remember the
number that was last used even when you close down the program, so you can take a break from
the contest to eat.  When you come back the number will be the same as when you left.  To restore
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the number back to zero at the end of the contest or at the beginning of a new one simply go to the
‘User Defined Macro Variables’ tab in the Settings window and change the number in the {sn}
field to 0. If you would rather update {sn} manually rather than automatically, put a check mark
beside “Manually update S/N”.  This will bring up the following dialog box whenever you use a
macro containing {sn}.

Checking the “Append zeros to S/N” box, will add zeros to the beginning of the serial number.
For example, serial number 1 would appear as 001.

For example, assume the settings were filled in with these values:

{call} – KF4WGU

{name} – Sydney

{mycall} – N4GDO

{myname} – ricker

{selcal} – ngdo

{qth} – Florence, AL

You could set up a macro like this:

{call} DE {mycall} Hi there {name}, My name is {myname}, and my QTH is {qth}.  My
Selcal is {selcal}.  The current time is {time} and the current date is {date}.

When the macro is invoked, it would type this to the screen:

KF4WGU de N4GDO Hi there Sydney, My name is ricker, and my
QTH is Florence, AL.  My Selcal is ngdo.  The current time is
09:33:41 and the current date is Wednesday, June 17, 1998.
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KAM XL PSK-31 Options

This screen allows you to select between BPSK and QPSK as your default PSK-31 mode for the
KAM XL.  This screen will not be visible if you do not have a KAM XL.
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HF Edit Menu

HF Edit Menu Options

Cut - Use this command to remove the currently selected data from the session and put it on the
clipboard

Copy - Use this command to copy selected data onto the clipboard.

Paste - Use this command to insert a copy of the clipboard contents at the insertion point.

Clear Screen - Clears the text from the active text window.

Repeat Last Text - Repeats the last text you sent.  The text will be put into the active chat
window.

Copy To Call Exchange – Allows you to copy a call sign into the call exchange buffer.

Call Exchange  - Takes the call sign you have copied with the Copy to Call Exchange and
appends it to the information that was created in the settings for call exchange.

HF View Menu

HF View Menu Options

Toolbar - Use this command to display and hide the Toolbar.

Status Bar – Use this command to display and hide the Status Bar.

Wordwrap – Use this command to cause the text to continue on the next line when the end of the
screen is reached.
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(Check mark indicates it is being displayed)

HF Mode Menu

HF Mode Menu Options

CW – Sets the current HF Mode to CW.

RTTY – Sets the current HF Mode to RTTY.

ASCII – Sets the current HF Mode to ASCII.

NAVTEX - Sets the current HF Mode to NAVTEX.

AMTOR – Sets the current HF Mode to AMTOR.

Listen Amtor – Sets the current HF Mode to Listen AMTOR.

FEC – Sets the current HF Mode to FEC.

PACTOR - Sets the current HF Mode to PACTOR.

GTOR – Sets the current HF Mode to GTOR.

GMon – Places the KAM in GTOR Monitor mode.

KAM XL PSK31 – Sets the current HF Mode to KAM XL PSK31 when the TNC is a KAM XL.

Sync with Log Windows – Allows PacTerm for Windows to sync with Log Windows™.  Both
Log Windows and PacTerm for Windows must be running to use this command.

Sync with Dx4Win - Allows PacTerm for Windows to sync with Dx4Win™.  Both Dx4Win and
PacTerm for Windows must be running to use this command.
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CW

CW is the acronym for continuous wave.  CW is another name for Morse code.

To make a CW contact you must:

1) First Open a New HF Window from the File menu.

2) You need to be in CW Mode.  To check your mode, look at the status bar.

3) To change modes:

a) Select CW from the Mode menu.

b) Click on the CW button  in the toolbar.

4) Once you are in the correct mode (notice the mode in the status bar), you need to tune to the
CW signal according to the specifications in your Kantronics TNC manual.

5) When it is tuned correctly, you will start to see the CW characters in the text window.

6) Now you are ready to reply or call CQ.  There are two ways to accomplish this.

a) Type text in the chat box and press <Enter>.  Pressing <Enter> turns on transmit; it then
transmits the text from the chat box and then switches back to receive automatically. Use
<Ctrl-Enter> to send a carriage return without turning on the transmitter.

b) You can also click the Transmit button  in the toolbar and type your message in the
chat box.  With this you send one (1) character at a time.  Then you must click the Receive

button  to receive.  This clears the chat buffer.

7) Now you are ready to Call CQ again or Receive CW from another station.

RTTY

RTTY is the acronym for Radio Teletype.

To make a RTTY contact you must:

1) First Open a New HF Window from the File menu.

2) You need to be in RTTY Mode.  To check your mode, look at the status bar.

3) There are two ways to change modes:

a) Select RTTY from the Mode menu.

b) Click the RTTY button  in the toolbar.
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4) Once you are in the correct mode (notice the mode in the status bar), you need to tune to the
RTTY signal according to the specifications in your Kantronics TNC manual.

5) When it is tuned correctly, you will start to see the RTTY characters in the text window.

6) Now you are ready to reply or call CQ.  There are two ways to accomplish this.

a) Type text in the chat box and press <Enter>.  Pressing <Enter> turns on the transmitter.
It then transmits the data to the TNC, and then switches back to receive automatically.
Use <Ctrl-Enter> to send a carriage return without turning on the transmitter.

b) You can also click the Transmit button  on the toolbar and type your message in the
chat box.  With this you send one (1) character at a time.  Then you must click the Receive

button  to receive.  This clears the chat buffer.

7) Now you are ready to Call CQ again or Receive RTTY from another station.

ASCII

To connect to ASCII:

1) First Open a New HF Window from the File menu.

2) To change modes:

a) Select ASCII from the Mode menu.

b) Click on the ASCII button  in the toolbar.

3) Once you are in the correct mode (notice the Mode in the status bar), you need to tune to the
ASCII signal according to the specifications in your Kantronics TNC manual.

4) When it is tuned correctly, you will start to see the ASCII characters in the text window.

5) Now you are ready to reply or call CQ.  There are two ways to accomplish this.

a) Type data in the chat box and press <Enter>.  Pressing <Enter> turns the transmitter on.
It then transmits the data to the TNC, and then switches back to receive automatically.
Use <Ctrl-Enter> to send a carriage return without turning on the transmitter.

b) You can also click the Transmit button  in the toolbar and type your message in the
chat buffer.  With this, you send one (1) character at a time.  Then you must click the

Receive button  to receive.  This clears the chat buffer and turns off the transmitter.

6) Now you are ready to Call CQ again or receive ASCII from another station.
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NAVTEX

NAVTEX is transmitted with Mode B AMTOR (FEC).  NAVTEX is sent with a unique message
format to identify the sending station, the type of message, and the message sequence number.
NAVTEX is a receive-only mode.

1) First Open a New HF Window from the File menu.

2) You need to be in NAVTEX Mode.  To check your mode, look at the status bar.

3) There are two ways to set the mode.

a) Select NAVTEX from the Mode menu.

b) Click on the NAVTEX button  in the toolbar.

4) Once you are in the correct mode (notice the mode in the status bar), you need to tune to the
NAVTEXT signal according to the specifications in your Kantronics TNC manual.

AMTOR

There are two basic modes for AMTOR operation.  Mode A operation is called ARQ.  ARQ is a
one-to-one mode, meaning you are allowed to communicate with only one station at a time.
Mode B operation is called FEC.  This mode is similar to RTTY.  Unlike ARQ, FEC is a
continuous broadcast.

To make an AMTOR contact you must:

1) First Open a New HF Window from the File menu.

2) You need to be in Listen AMTOR Mode.  To check your mode, look at the status bar.

3) To change modes:

a) To connect to Mode A.

i) Select Listen AMTOR Mode from the Mode menu.

ii) Click on the Listen AMTOR button .  Tune to the AMTOR signal according to the

specifications in your Kantronics TNC Manual.

iii) Click the AMTOR button  if you want to call CQ.  Then click the “T” button to

turn on the transmitter.

iv) To link to another station, you need to select Link from the AMTOR menu or click on

the Link button .  Link will bring up a connect box where you need to enter the

SELCAL of your contact.
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v) To Call a CQ:

(1) Type text in the chat box and press <Enter>.  Pressing <Enter> turns on transmit.
It then transmits the data to the TNC and then switches back to receive
automatically. Use <Ctrl-Enter> to send a carriage return without turning on the
transmitter.

(2) You can also click on the Transmit button , and type your message in the chat

box.  With this you send one (1) character at a time.  Then you must click the

Receive button  to receive.  This clears the chat buffer.

vi) To disconnect, select the disconnect option from the AMTOR menu or click the

Disconnect button .

b) To connect to Mode B.

i) To change Modes:

(1) Select FEC Mode from the Mode menu

(2) Click on the FEC button  in the toolbar.

ii) Once you are in the correct mode (notice the mode in the status bar), you need to tune
to the FEC signal according to the specifications in your Kantronics TNC manual.

iii) When it is tuned correctly, you will start to see the FEC characters in the text window.

iv) Now you are ready to reply or call CQ.  There are two ways to accomplish this.

(1) Type text in the chat box and press <Enter>.  Pressing <Enter> turns on transmit.
It then transmits the data to the TNC and then switches back to receive
automatically. Use <Ctrl-Enter> to send a carriage return without turning on the
transmitter.

(2) You can also click the Transmit button  and type your message in the chat

buffer.  With this you send one (1) character at a time.  Then you must click the

Receive button  to receive.  This clears the chat buffer and turns off your

transmitter.

v) Now you are ready to Call CQ again or receive FEC from another station.
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Listen AMTOR

Listen AMTOR allows you to tune to an ARQ signal without being part of the link.  From Listen
AMTOR you are able to display the text, but no error correction takes place.

To connect to Listen AMTOR.

1) First Open a New HF Window from the File menu.

2) There are two ways to select the mode.

a) Select LAMTOR from the Mode menu.

b) Click on the Listen AMTOR button  in the toolbar.

3) Once you are in the correct mode (notice the mode in the status bar), you need to tune to the
Listen AMTOR signal according to the specifications in your Kantronics TNC manual.

This option places the KAM in the Listen AMTOR Mode.  The KAM will receive FEC, SELFEC,
or ARQ Signal and will not transmit when in LAMTOR Mode.  You can link to a station in

LAMTOR Mode.  Click on the Link button  and type in the call sign.  PacTerm for Windows

will set the TNC into AMTOR Mode to make the connection.

FEC

FEC is the acronym for Forward Error Correction.  This is Mode B in AMTOR.

To connect to FEC (Mode B):

1) First Open a New HF Window from the File menu.

2) To change modes:

a) Select FEC from the Mode menu.

b) Click on the FEC button  in the toolbar.

3) Once you are in the correct Mode (notice Mode in status bar), you need to tune to the FEC
signal according to the specifications in your Kantronics TNC manual.

4) When it is tuned correctly you will start to see the FEC characters in the text window.

5) Now you are ready to reply or call CQ.  There are two ways to accomplish this.

a) Type text in the chat box and press <Enter>.  Pressing <Enter> turns the transmitter on.
It then transmits the data to the TNC and then switches back to receive automatically. Use
<Ctrl-Enter> to send a carriage return without turning on the transmitter.
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b) You can also click on the Transmit button  in the toolbar and type your message in the

chat box.  With this you send one (1) character at a time.  Then you must click on Receive

button  to receive.  This clears the chat buffer.

6) Now you are ready to Call CQ again or receive FEC from another station

PACTOR

PACTOR uses a handshaking system to send data.  An ACK acknowledgment is sent when data
is received intact and a NAK is sent for corrupted data.

1) First Open a New HF Window from the File menu.

2) You need to be in PACTOR Mode.  To check the mode, look at the status bar.

3) There are two ways to change modes:

a) Select PACTOR from the Mode menu.

b) Click on the PACTOR button  in the toolbar.

4) Once you are in the correct mode (notice the mode in the status bar), you need to tune to the
PACTOR signal according to the specifications in your Kantronics TNC manual.

5) When it is tuned correctly, you will start to see the PACTOR characters in the text window.

6) Now you are ready to request a link or call CQ.

7) To connect select the PACTOR Connect option from the Packet menu and then type in the
call sign of your contact and press the Connect button.  To change from IRS to ISS use the
appropriate button.

8) To call CQ you need to click the Transmit button  in the toolbar and type your message in

the chat box.  With this you send one (1) character at a time.  Then you must click the Receive

button  to receive.  This clears the chat buffer.

9) To disconnect select PACTOR Disconnect.

GTOR

GTOR is the acronym for Golay-coded Teleprinting Over Radio.

1) First Open a New HF Window from the File menu.

2) You need to be in GTOR Mode.  To check your mode, look at the status bar.

3) There are two ways to set the mode.
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a) Select GTOR from the Mode menu.

b) Click on the GTOR button  in the toolbar.

4) Once you are in the correct mode (notice the mode in the status bar), you need to tune to the
GTOR signal according to the specifications in your Kantronics TNC manual.

5) When it is tuned correctly, you will start to see characters in the text window.

6) Now you are ready to request a link or call CQ.

7) To connect, you need to select the link option from GTOR menu, and enter the call sign of
your contact.  To change from IRS to ISS use the appropriate button based on your current
IRS/ISS status.

8) To call CQ, you need to click Transmit button  in the toolbar and type your message in the

chat box.  With this you send one (1) character at a time.  Then you must click the Receive

button  to Receive.  This clears the chat buffer.

9) To disconnect select GTOR disconnect.

GMON

Places the KAM in GTOR Monitor mode.

PSK31

PSK31 is the acronym for Phase Shift Keying 31 baud.  To make a PSK31 contact you must:

1) First Open a New HF Window from the File menu.

2) You need to be in PSK31 Mode.  To check your mode, look at the status bar.

3) To change modes, you can do one of the following:

a) Select PSK31 from the Mode menu.

b) Click on the PSK31 button  in the toolbar.

4) Once you are in the correct mode (notice the mode in the status bar), the PSK31 Control
Panel comes up.

5) Click on signal with your mouse in either the Spectrum display window or the Waterfall
display window to select it.

6) Now you are ready to reply or call CQ.  There are two ways to accomplish this.

a) Type text in the chat box and press <Enter>.  Pressing <Enter> turns on transmit; it then
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transmits the data from the chat box, and then switches back to receive automatically. Use
<Ctrl-Enter> to send a carriage return without turning on the transmitter.

b) You can also click the Transmit button  and type your message in the chat box.  With

this you send one (1) character at a time.  Then you must click the Receive button  to
receive.  This clears the chat buffer.

7) Now you are ready to Call CQ again or Receive PSK31 from another station.

KAM XL PSK31

Selecting this option allows you to use the PSK31 option in the KAM XL TNC.  This option is
only available with the KAM XL.  To start the KAM XL PSK31, select either the KAM XL PSK31

option under the HF Mode menu or click the KAM XL PSK31 button on the Toolbar .  This

will bring up the KAM XL PSK31 Control Panel.

To make a KAM XL PSK31 contact you must:

1) First Open a New HF Window from the File menu.

2) You need to be in the KAM XL PSK31 Mode.  To check your mode, look at the status bar.

3) To change modes, you can do one of the following:

a) Select KAM XL PSK31 from the Mode menu.

b) Click on the KAM XL PSK31 button  in the toolbar.

4) Once you are in the correct mode (notice the mode in the status bar), the KAM XL PSK31
Control Panel comes up.

5) Select either BPSK or QPSK mode.

6) Tune your radio to a PSK31 frequency.

7) You are now ready to tune in a PSK31 signal.

a) Use the Led 1 through Led 10 Zoom buttons on the KAM XL PSK31 Control Panel to
zoom in on a signal.  Each LED on the KAM XL display represents one or more signals.
Repeat this four times.

b) Once you have zoomed in on a signal, use Led 1 through Led 10 to tune, or center, the
PSK31 signal.  The Led 1 button will move the lights on the KAM XL display furthest to
the right.  The Led 10 button will move the lights on the KAM XL display furthest to the
left.

c) Once a signal is tuned, PacTerm for Windows will start to display characters in the text
window
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8) Now you are ready to reply or call CQ.  There are two ways to accomplish this.

a) Type text in the chat box and press <Enter>.  Pressing <Enter> turns on the transmitter.
It then transmits the data to the TNC, and then switches back to receive automatically.
Use <Ctrl-Enter> to send a carriage return without turning on the transmitter.

b) You can also click the Transmit button  in the toolbar and type your message in the

chat box.  With this you send one (1) character at a time.  Then you must click the Receive

button  to receive.  This clears the chat buffer.

9) To tune another signal, click the Zoom Out button a maximum of four times and select
another signal to tune.

Sync with logging program

Selecting this option allows you to sync PacTerm with either Log Windows or DX4Win.

Format Menu

Format Menu Options

Font - The Font command allows the user to select the type, style and the size of the font used to
display text in the window.

Color – In the Text Box, the Color command allows the user to select the colors of the text, the
transmitted text, the command text, and the background.  In the Chat Box, the user can change the
color of the chat text and the background.

Font Command

The Font command allows the user to select the type, style, and the size of the font used to
display text.
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Color Command

The Color command allows the user to select the color of the text and background for the text
box, the chat box, the transmitted text color, and the commands text color.
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Selecting any of the four-color boxes brings up the following Color Chart.  By selecting the
Define Custom Colors, you are able to choose from common colors for background or you can
define new colors to use.

HF File Transfer Menu

HF File Transfer Menu Options

This is the HF File Transfer menu.

Send ASCII - Sends an ASCII file with no protocol.
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HF TNC Menu

HF TNC Menu Options

Commands – These are some commands available in HF for the TNC.

Xmit On - Turns the transmitter on.

Xmit Off - Turns the transmitter off.

Pause Xmit - Returns to Receive Mode immediately in FEC.

Kill Xmit Buffer - This stops the transmission and clears out the KAM transmit buffer.

Transmit On

Turns the transmitter on in a non-linked mode.  There are three ways to turn Transmit On:

7) Click on the Transmit button .

8) Press F4.

9) Select Transmit On from the HF TNC menu.

Hotkey: F4

Transmit Off

Turns the transmitter off in a non-linked mode.  There are three ways to turn Transmit off:

10) Click on the Receive button  to change from Transmit to Receive.

11) Press F4 or F5.

12) Select Transmit Off from the HF TNC menu.

Hotkey: F4 or F5
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Pause Xmit

Pause Transmit Option.  Returns to Receive Mode immediately in FEC.  Characters still in the
KAM transmit buffer will remain there.

Kill Xmit Buffer

Kill Transmit Buffer.  This stops the transmission and clears out the KAM transmit buffer.

CW Menu

CW Menu Options

Lock CW Speed – Lock CW Speed causes the TNC to lock the CW transmit speed to the speed
of the CW signal being received.

CW Speed - This command sets the CW speed used when entering the CW Mode.

CW Speed

This sets the speed in words per minute for sending CW.  The CW speed must be between 5 wpm
and 99 wpm.

Lock CW Speed

Lock CW Speed causes the TNC to lock the CW transmit speed to the speed of the CW signal
being received.
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RTTY Menu

RTTY Menu Options

Invert - Signals received in RTTY, ASCII, or AMTOR, and signals transmitted using AFSK are
inverted.

Baud Rate - This sets the baud rate for each Non-Packet Mode.

Shift Tone (RTTY – ASCII - AMTOR)  - Sets the default shift used in RTTY, ASCII, AMTOR,
NAVTEX, and PACTOR Modes.

Invert (RTTY - ASCII)

Signals received in RTTY, ASCII, or AMTOR, and signals transmitted using AFSK are inverted.

Baud Rate

This sets the baud rate for each Non-Packet Mode.

For RTTY you have these options: from 45-300 baud rate.

For PACTOR and AMTOR you have these options: 100, 200, 300, and Auto.

Shift Tone (RTTY - ASCII_AMTOR)

Sets the default shift used in RTTY, ASCII, AMTOR, NAVTEX, and PACTOR Modes.



116  - PacTerm for Windows

ASCII Menu

ASCII Menu Options

Invert - Signals received in RTTY, ASCII, or AMTOR, and signals transmitted using AFSK are
inverted.

Baud Rate - This sets the baud rate for each Non-Packet Mode.

Shift Tone (RTTY – ASCII - AMTOR)  - Sets the default shift used in RTTY, ASCII, AMTOR,
NAVTEX, and PACTOR Modes.

Navtex Menu

NAVTEX Menu Options

Invert - Signals received in RTTY, ASCII, or AMTOR, and signals transmitted using AFSK are
inverted.

Shift Tone (RTTY – ASCII - AMTOR)  - Sets the default shift used in RTTY, ASCII, AMTOR,
NAVTEX, and PACTOR Modes.
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Amtor Menu

AMTOR Menu Options

Link – Links to an AMTOR station.

Disconnect – Disconnects from an AMTOR station.

Invert – Signals received in RTTY, ASCII, or AMTOR, and signals transmitted using AFSK are
inverted.

Shift Tone (RTTY – ASCII - AMTOR)  - Sets the default shift used in RTTY, ASCII, AMTOR,
NAVTEX, and PACTOR Modes.

Get WRU – Who Are You text.  Gets personal information from WRU

LAMTOR – Listen AMTOR

SELFEC – When SELFEC is selected PacTerm for Windows will begin a Mode B SELFEC
broadcast.

AMTOR Link

The AMTOR Connect command connects to a packet station depending on the call sign entered.

AMTOR Disconnect

The AMTOR Disconnect command disconnects from a packet station.

Get WRU

Who Are You text.  Gets personal information from WRU text.
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LAMTOR

To Connect to Listen AMTOR.

1) First Open a New HF Window from the File menu.

2) There are two ways to select the mode.

a) Select LAMTOR from the Mode menu.

b) Click on the Listen AMTOR button  in the toolbar.  Tune to the AMTOR signal

according to the specifications in your Kantronics TNC manual.

3) Once you are in the correct mode (notice the mode in status bar), you need to tune to the
Listen AMTOR signal according to the specifications in your Kantronics TNC manual.

This option places the KAM in the Listen AMTOR Mode.  The KAM will receive FEC, SELFEC,
or ARQ Signal and then will not transmit when in LAMTOR Mode.  You can link to a station in

LAMTOR Mode.  Click the Link button  and type in the call sign.  PacTerm for Windows will

set the TNC into AMTOR standby mode to make the connection.

Listen AMTOR allows you to tune to an ARQ without being part of the link.  From Listen
AMTOR you are able to display the text but no error correction takes place.

This option allows you to upload ASCII files while connected to another station.  To send an
ASCII file, when you choose this option, you will be presented with a dialog box asking you for
the filename.  Chose the filename and press OK.  The file will then be transferring at 256 bytes at

a time.  To abort the transfer, click on the Stop button  or choose the stop transfer menu

option.

SELFEC

When you pick this option, PacTerm for Windows will begin a Mode B SELFEC broadcast.  You
will be presented with a window requiring you to enter the SELCAL.  Enter the SELCAL and
click the OK button.  This will turn the transmitter on and send the SELCAL as the preamble to a
transmission, followed by any text you type into the chat window.  To return to Receive Mode,

click on Receive button  or press F5.  At this time, you will only be able to receive SELFEC

transmission, To receive any FEC transmission, press F10 and type “auto-start off” (without the
quotes).  To send another SELFEC broadcast, select the SELFEC menu option.



119 - PacTerm for Windows

Figs and Letters

If you suddenly notice your incoming text shift to numbers, choose the Figs option to restore text
to normal.  If your numbers shift to text, use the Letters option to restore numbers to normal.

Pactor Menu

PACTOR Menu Options

These are the PACTOR commands.

PACTOR Connect –The PACTOR Connect command connects to a packet station depending on
the call sign entered.

PACTOR Disconnect - The PACTOR Disconnect command disconnect from a packet station

Abort PACTOR Link – Aborts a link in progress.

PACTOR Baud – Sets the baud for PACTOR.

Shift  - Sets the Shift of the PACTOR signal.

PACTOR Listen – Selecting this menu option puts the KAM in PACTOR Listen Mode.

PACTOR Connect

The PACTOR Connect command connects to a packet station depending on the call sign entered.

PACTOR Disconnect

The PACTOR Disconnect command disconnects from a packet station.
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Abort PACTOR Link

Choose this option during the link phasing process if you wish to abort the link.  Once chosen,
the current link attempt will be aborted.

PACTOR Baud

This is used to set the speed to be used for a PACTOR FEC (non-linked) connection.  When set to
100, all FEC transmissions will be at 100 baud, and when set to 200, FEC transmissions will be at
200 baud.

PACTOR Listen

Selecting this menu option puts the KAM in PACTOR Listen Mode.  This Mode will allow you
to copy FEC or ARQ (Linked) PACTOR stations, but you cannot transmit from this Mode.  You

can link to a station by clicking the Link button , which returns to PACTOR Mode.  To exit

PACTOR Listen Mode, remove the check from the menu item or click the PACTOR button 

again.

GTOR Menu

GTOR Menu Options

GTOR Connect – This connect command connects to a GTOR station depending on the call sign
entered.

GTOR Disconnect - This command disconnect from a GTOR station

Abort GTOR Link – Aborts a link in progress.

GTOR Baud – Sets the GTOR baud rate

Shift – Sets the Shift of the GTOR signal.

GMON - Places the KAM in monitor mode.
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GTOR Connect

The GTOR Connect command connects to a packet station depending on the call sign entered.

GTOR Disconnect

The GTOR Disconnect command disconnects from a packet station.

Abort GTOR Link

Choose this option during the link phasing process if you wish to abort the link.  Once chosen,
the current link attempt will be aborted.

GTOR Baud

This is used to set the speed to be used for a GTOR FEC (non-linked) connection.  When set to
100, all FEC transmissions will be at 100 baud, and when set to 200, FEC transmissions will be at
200 baud.

GTOR Monitor

Clicking on the GTOR Monitor button  or choosing GMON from the GTOR menu places the

KAM in the monitor mode (if your TNC supports GTOR), allowing you to monitor GTOR QSOs.
To exit the GMON Mode and return to the command prompt, press the button again or deselect
GMON from the GTOR menu.

LookUp Menu

LookUp Menu Options

Call Sign - Allows the user to look up a particular call sign.
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Call Sign LookUp Command

The Call Sign LookUp command allows the user to look up a particular call sign.  You enter the
call sign and then it looks it up on the CallBook that is specified in the Setting section to see
whom it belongs to and then it displays the information.  Before the information is returned from
the CD CallBook, you can enter or modify the contact information for that station in PacTerm’s
contact database.
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Macros Menu

Macros Menu Options

Macro - User-defined text that is associated with a particular keystroke.  There are 10 global
macros for VHF, 10 global macros for HF and 10 mode-specific macros for HF.  To create a
macro, select the Settings option from the File menu and then select the Edit Macros tab.  This will
give you the Edit Macro Settings page.  Pick a name for the macro and then enter the information
in the macro text window.

Macros

Macros are messages that the user is able to define and assign to a keystroke.  You can create up
to ten different global macros in both Packet and Non-Packet HF Modes.  You can also create up
to ten different macros for each of the HF modes.
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PSK31 Control Panel

PSK31 Control Panel Options

When you start PSK31, the PSK31 Control Panel will come up.  The Control Panel has controls
used to tune a PSK31 signal as well as graphical displays for finding and tuning PSK31 signals.
The Control Panel contains Spectrum, Waterfall, Input, and Data Sync views of the signals.  Click
on the appropriate tab, to switch between the views.  Controls are located to the left and to the
bottom of the Control Panel.  To send text or to view received text, go to the Main HF View
window in PacTerm for Windows.

RX Freq - Receive Frequency.  Allows you to type in or select a receive frequency.  The new
frequency takes effect after the mouse cursor is clicked on another part of the Control Panel.

AFC - Automatic Frequency Control.  Selecting this option allows PSK31 to automatically tune to
the nearest signal.  To tune a frequency, click your left mouse button near a signal and AFC will
tune to the center frequency of the nearest signal.  You may need to turn AFC off under conditions
of poor propagation or when receiving a poor transmitting station. Otherwise, AFC may not lock
correctly on the center frequency.

TX Freq - Transmit Frequency.  Allows you to type in or select a transmit frequency.  The new
frequency takes effect after the mouse cursor is clicked on another part of the Control Panel.

Net - Forces transmitter to use current Receiver frequency. If both stations use it, they will tend to
move together across the band.  If neither station uses it, they may drift apart.  If only one station
uses it, the station not using Net becomes the “Master”.

BPSK - Binary PSK.  BPSK is the most commonly used mode but lacks forward error correction.
BPSK is indicated in the Vector Display as two vertical lines.

QPSK - Quadrature PSK.  QPSK has forward error correction but can be harder to tune.  It is
indicated in the Vector Display as two vertical and two horizontal sets of lines. QPSK is sensitive
to sideband so you must select either upper sideband (usb) or lower sideband (lsb).
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SQ - Squelch Control.  This bar graph sets the signal quality threshold to reduce reception of
garbage characters.  It acts by inhibiting reception until the signal exceeds a specified level.  The
vertical bar at the bottom will get longer as the signal quality increases.  A small blue horizontal
bar indicates the current squelch threshold and can be moved with the mouse to the desired
threshold.  Signals must exceed this threshold for characters to be displayed.  The color of the bar
is gray when it is below the squelch threshold bar and changes to yellow when it increases above
the squelch threshold bar.

Slow - This option smoothes out the spectral display.  However, you may lose fast changing
signals.

Zoom - Zoom allows you to look at smaller or larger areas of the display.  The display zooms
around the current frequency cursor position.   The lowest displayed frequency is shown to the left
of the display.  The highest frequency is shown to the right of the display.  Click the arrow buttons
to zoom in or out.

PSK31 Spectrum Display

The PSK31 Spectrum Display graphs the incoming signal with frequency on the horizontal axis
and amplitude on the vertical axis.  The gray horizontal grid lines represent 10 dB gradient steps in
amplitude. The dashed vertical yellow line represents the current PSK31 receiver center frequency.
To automatically tune a frequency, put a check mark beside “AFC on the left side of the Control
Panel.  Then click the left mouse button on a signal.  The dashed vertical line will move to the
center frequency of the nearest signal.  The Vector Display in the upper left corner can be used to
help find PSK signal.  Two vertical lines going in opposite directions from the center will indicate a
BPSK signal.  A QPSK signal will be indicated by two vertical and two horizontal lines from the
center.  A right mouse click on the display will also change the receiver frequency and “rewinds”
the audio back 25 seconds.
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PSK31 Waterfall Display

The Waterfall Display is similar to the Spectrum Display.  A Spectrum is displayed at the top.
Below that is the Waterfall.  In the Waterfall Display, the horizontal axis is frequency and the
vertical axis is time.  Horizontal lines are added to the top of the Waterfall Display, pushing older
horizontal lines down one notch.  The brightness and color of a horizontal line indicate amplitude.
As the amplitude at a particular frequency becomes stronger, that area of the line will become
brighter and the color will shift from blue to cyan to yellow to white.  As lines newer lines are
added to the top of the graph, you can see a “history” of the signal.  A dashed vertical yellow line
indicates the frequency where the receiver is currently centered.  Your mouse cursor can be used
to move the center frequency by clicking the left mouse button on a signal.  Clicking the right
mouse button will also move the center frequency and “rewind” the audio 25 seconds. The Vector
Display in the lower left corner can be used to help find PSK31 signals. Two vertical lines going in
opposite directions from the center will indicate a BPSK signal.  A QPSK signal will be indicated
by two vertical and two horizontal lines from the center.
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PSK31 Input Display

The Input Display shows the raw input signal with Amplitude on the vertical axis and Time on the
horizontal axis.   The Input Display is primarily used to adjust the receiver and sound card input
level.  The display changes from green to red when the input level becomes too high.

PSK31 Data Sync Display

The Data Sync Display shows a histogram of the internal signal to determine the center of the
received bit.  An elongated line marks the peak of the histogram.  The Data Sync Display can be
used to determine if the incoming signals or the user’s sound card is off frequency.
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KAM XL PSK31 Interface

KAM XL PSK31 Control Panel

If you are using a KAM XL, you can use PSK31 from the KAM XL by selecting either KAM XL

PSK31 from the Mode menu or clicking the KAM XL PSK31 button on the HF toolbar .  This

will bring up the KAM XL PSK31 Control Panel shown below.  Note that this option will not be
available if you don’t have a KAM XL.  The Zoom LED buttons 1 through Led 10 allow you to
zoom in on a signal and tune it.  Below the Zoom LED buttons is the Bandwidth.  You can also
select either BPSK or QPSK mode.

To zoom in on a PSK31 frequency, first turn your radio to a PSK31 frequency.  The ten LEDs on
the KAM XL front panel display will show where the PSK31 signals are.  Each light represents
one or more signals. To zoom in on a signal, click button representing the LED you wish to check.
For example, the Zoom LED 1 button will represent the far left LED light.  The Zoom LED 10
button will represent the far right LED light.  After this zoom, the LEDs may change position.
Select another LED button to zoom again.  Continue until you have zoomed down four levels.
Once you have zoomed in on a signal, you can tune it.  Below the Zoom LED buttons is the
Bandwidth.  The left-hand number corresponds to the lower edge of the bandwidth.  The right-
hand number corresponds to the upper edge of the bandwidth.  The middle number corresponds to
the center of the bandwidth.

To tune the signal so that the LEDs are centered on the KAM XL display, click the appropriate
LED button.  LED 1 will move the signal indicator lights farther to the right than LED 2.
Similarly, LED 10 will move the signal indicator lights farther to the left than LED 9.  The signal is
tuned when the indicator lights are centered.  Once it is tuned, it will start receiving the signals.

The Squelch Control at the bottom of the KAM XL PSK-31 Control Panel has 15 squelch levels (1
through 15).  There are several ways to change the squelch level.

• You can use your mouse to click on the desired level or you can drag the squelch pointer to the
desired level with your mouse.

• You can use the left and right arrow keys on your keyboard to move the squelch up or down one
level.
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• You can use the <Home> key on your keyboard to change the squelch to the lowest level of 1 or
you can use the <End> key on your keyboard to change the squelch to the highest level of 15.

To tune another signal, click the Zoom Out button a maximum or four times.

HF Packet Session

HF Packet

If you want to connect to HF packet, there are several things you will need to know to help you
out.  When using a Kantronics TNC, you will only be able to use a KAM, KAM-e, KAM 98, or
KAM Plus.

KAM 98

When using a KAM 98, you must remember that this TNC has only one radio port.  Because of
this, you must do a couple of things before starting a HF Packet session.  First you must make sure
that the HF Non-packet session window of PacTerm for Windows is closed.  Secondly go to the
File menu and choose Settings.  Then click on the Communications tab at the top of the window
that appears.  As you can see in this picture, you will see a section on the bottom of this screen
that allows you to select HF or VHF Packet mode for the next session.

Once you have selected the HF Packet mode, you will have to restart PacTerm for Windows for
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the change to take effect.  Once the HF session is open, you use the HF Packet window in the
same way as the VHF Packet window.

KAM, KAM-e, KAM Plus

If you are using any of these TNCs, then you will not have to change any settings or restart the
computer.  Because these TNCs use Radio Port 2 for HF and VHF Packet, all you have to do is
shut down the HF-non packet session window if it is open, then choose the File menu and choose
either New Port 2 Session or New HF Session.  Once the HF session is open you use the HF
Packet window the same as the VHF Packet window.
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Logging Programs

Synching with Logging Programs

Starting with PacTerm for Windows Version 1.3, you can sync a PacTerm session window with
Log Windows.  With Version 1.4 of PacTerm for Windows you may also sync with DX4WIN.

Synching with a logging program can be very useful when doing contests and saving QSOs.  Using
a logging program like DX4WIN or Log Windows helps to simplify connecting and navigating a
DXCluster.

Log Windows Interface

PacTerm for Windows provides a TNC interface for Log Windows Version 2.0.  Data being
received or echoed by the TNC can be sent to Log Windows.  Likewise data typed in the Log
Windows transmit window can be sent to the PacTerm window.  PacTerm for Windows acts as a
data engine for Log Windows.  One of the user port windows in PacTerm for Windows can be
redirected to the Log Windows TNC Window, allowing full two-way communications between
Log Windows and a TNC through PacTerm for Windows.  For example, if you are using a dual
port TNC such as the Kantronics 9612 and PacTerm for Windows you may,

13) Redirect TNC Port 2, which is VHF Packet for use with Log Windows.

14) Use TNC Port 1 for other HF digital modes.

As you can see, you may enjoy the benefits of true dual port operating while sharing the power of
PacTerm for Windows and Log Windows.  Log Windows 2.0 or greater is required.  All PacTerm
for Windows functions are still enabled while communicating with Log Windows.

Synchronizing PacTerm for Windows with Log Windows

PacTerm for Windows must first become aware that Log Windows is running.  To do this:

15) Get both programs running.

16) Select the Mode menu and choose Sync with Logging Program, then choose Log Windows.

Once you have Synched PacTerm for Windows and Log Windows simply minimize PacTerm for
Windows and you can communicate with the TNC using Log Windows.  For more information on
using Log Windows, consult the Log Windows program documentation.

DX4WIN

PacTerm for Windows can synchronize with DX4WIN version 4.06 or greater.  In order to use
DX4WIN with PacTerm for Windows you must first set up DX4Win to recognize PacTerm for
Windows.



132  - PacTerm for Windows

To setup DX4WIN simply:

1) Open DX4WIN.

2) Click on the File menu at the top of the window.

3) Choose Preferences.

4) A window that says ‘Setup Parameters’ should appear.  On the right side of the window you
should see about 16 tabs.  Choose the tab that says Packet1

5) At the top of the window under the TNC interface section type the following in:

a) Type : Regular

b) COM Port: Msg

c) Message Handshake: CSS TNC PROGRAM|PacTerm ‘98

Important: Upper case, lower case, and spacing for Message Handshake must match what is
shown here.

d) In the above message the | character before PacTerm ’98 is called a ‘Pipe’ and is located
above the \ key on your keyboard (on the keyboard it looks like a stretched out colon).
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6) Click on the File menu and choose Save Changes.

Now DX4WIN is ready for use with PacTerm for Windows.  Simply load PacTerm for Windows

and DX4WIN at the same time and click on the  button on the toolbar.  Or click on the Mode

Menu at the top of the PacTerm for Windows  window and choose Sync with Logging Program
and then choose DX4WIN.
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Rig Control

Getting Started with Rig Control

Starting in Version 1.4 of PacTerm for Windows, a basic form of Rig Control has been included to
make your life easier while surfing the airwaves and using PacTerm for Windows.  The design of
the Rig Control option in PacTerm for Windows was intended to be intuitive and second nature, so
you will no longer have to keep scooting around your shack going from the computer to the radio
to change frequencies and then back to the computer again.  Hey, if you had a long enough serial
cord and a laptop, you could even make contacts while you’re watching your favorite shows in the
living room!

Before we get started you will need to make sure you have all the things required to use the Rig
Control Feature.

17) A transceiver that is on the compatibility list below.  (This is just a preliminary list.  Newer
versions of rig control will support more transceivers.)

18) A RS-232 Interface for Rig Control that is compatible with your Transceiver

19) A computer with two open serial ports (one for the TNC and one for the RS-232 interface.)

NOTE:  THE RIG CONTROL SOFTWARE IS IN PREVIEW.  IF YOU EXPERIENCE
ANY PROBLEMS WITH IT PLEASE COMMUNICATE THEM TO
RIGCONTROL@CSSINCORP.COM

Transceiver Compatibility list:

Manufacturer Model Manufacturer Model

Alinco: DX-77 Ten-TEC: 535
ICOM: IC-707 Ten-TEC: 536
ICOM: IC-725 Ten-TEC: 563
ICOM: IC-726 Ten-TEC: 564
ICOM: IC-728 Ten-TEC: OMNI-VI
ICOM: IC-729 Yaesu FT-1000
ICOM: IC-735 Yaesu FT-757GX
ICOM: IC-736 Yaesu FT-840
ICOM: IC-737 Yaesu FT-900
ICOM: IC-738 Yaesu FT-990
ICOM: IC-751A
ICOM: IC-756
ICOM: IC-761
ICOM: IC-765
ICOM: IC-781
Kenwood: TS-450S
Kenwood: TS-50S
Kenwood: TS-690S
Kenwood: TS-850
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Kenwood: TS-950S

See the Setting up Rig Control section of this help file for more information on setup.

Setting up Rig Control

Now that you’ve got everything you need to take advantage of Rig Control.  All you have to do to
set it up is plug the RS-232 Interface into your rig and then plug the other end of the RS-232
Interface into your open serial port.  Once the hardware is set up, just load the Rig Control
program.  The first time you load the Rig Control program you should see a screen telling you that
you need to configure it for your computer and radio.  The screen should look like this:

Once you see this window just click on the ‘OK’ button to proceed to the next screen.

The next window you will see will be the actual Settings screen.  If you ever have to change a
setting this is where you will do so.
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The first thing to do is select the COM port that the RS-232 Interface for your radio is connected
to.  For most people it will be either COM 1 or COM 2 since these are usually the 2 external serial
ports on a computer.  Be warned though that people using a serial mouse will either have to have a
PS/2 mouse or obtain an additional external serial port.

The second thing you will need to do on this Settings screen is to select the baud rate of the serial
port the radio is on.  The baud Rate depends on what the interface for the radio is set for.  The
default baud rates for the radio’s are:

RADIO BAUD

Kenwood 4800
ICOM 1200
Yaesu 4800
Alinco 9600
Ten-Tech 1200

The baud rates may be changed if so desired.  Please consult your radio’s users manual for
information on how to change the radio’s baud rate.

See the Using Rig Control section of this help file for information on using the controls on the Rig
Control screen.
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Using Rig Control

Now that you’ve got the Rig Control set up you can have lots of fun without having to keep
reaching over and tuning the radio manually.  You should now see this screen when you run Rig
Control.

Starting off at the top of the window you should see a large digital display.  This is the frequency
to which the radio is set.  If you look at your radio when this window pops up you should see it is
set to this frequency.

There are several ways to tune the radio.  For general tuning you can use the knob to tune quickly
to a different frequency.  This lets you tune faster but it is harder to fine tune to a specific
frequency.  Once you get into the general area that you want, simply use the up and down arrows
found below the frequency display.

If you’re interested in changing bands then you can click the ‘500 kHz UP’ or the ‘500 kHz
DOWN’ button to raise or lower the frequency by 500 kHz.

The modes simply let you change the radio between Upper Side Band (USB), Lower Side Band
(LSB), CW, AM, or FM.

DLOCK - Locks the dial so you cannot tune with the dial on the radio.  You can still tune with the
Rig Control software though.

TUNE - Sets your Antenna Tuner.

UP and DOWN - Depending on the radio, these buttons will either switch up and down a band or
change the frequency up or down 100 kHz.

CLAR - This is a clarifier.  When this button is pressed, you can tune and change bands to change
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the receiving frequency without changing the transmitting frequency.  When the button is
depressed then the receiving frequency changes back to the original frequency.

Underneath the Meter at the upper-right hand corner of the rig control window you will notice a
group of buttons.  These buttons are VFO A/B, SPLIT, MEMO, VFO->M, AND M->VFO.

••••• VFO A/B – Pressing this button causes the frequency data in the VFO A and VFO B registers to
be exchanged.  If this button is pushed again then the frequency data will be exchanged again,
returning it to its original frequency.

••••• SPLIT – Pressing this button enables split frequency operation, letting you switch from simplex
to duplex operation.  The frequency shown will be the receiving frequency until you key the mike
and then the frequency shown will be changed to the transmitting frequency.

••••• VFO->M - This button writes the frequency data from the selected VFO into the last selected
memory channel.

••••• M->VFO – This button writes the frequency data from the last selected memory channel into the
last selected VFO.  The memory data remains unchanged in the memory, but previous data in the
VFO is overwritten.

NOTE: NOT ALL RADIOS WILL SUPPORT ALL OF THESE FUNCTIONS.  FOR
MORE INFORMATION ON YOUR RADIO’S FUNCTIONS PLEASE CONSULT YOUR
RADIO’S MANUAL.

When you’re done using the Rig Control simply press the OK button at the bottom of the window
to close it out.  To change the settings for the Rig Control (i.e. baud rate or COM port) click on
the Setup button.  This will take you back to the same setup screen you saw when you first setup
the rig control feature.  For more information on setting up Rig Control or changing the settings
please see the Setting up Rig Control section of this help file.
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TroubleShooting

Troubleshooting Tips

If you were unable to establish communications with your TNC using PacTerm for Windows, you
can use the terminal program titled HyperTerminal to determine whether or not your TNC is
talking to the serial port properly.  Once the TNC is operational with HyperTerminal, you can go
back and troubleshoot installing PacTerm for Windows.  Alternatively, you may choose to go to
DOS and use PacTerm for DOS that was shipped with your TNC (This is not PacTerm for
Windows) to establish that your computer and TNC are working together over the serial port.

If you choose to use HyperTerminal, you will have to set up a program name, the COM port, and
baud rate for your TNC.  Bring up HyperTerminal by clicking on Start, then Programs, then
Accessories, and selecting HyperTerminal.  If you can’t find HyperTerminal, it may be located
under the Communications menu or you may need to install it from your Windows CD.  It will
initially ask you for a name (this is a name of the configuration you will make to test your TNC).
Enter a name such as TEST and click on OK.  Next select the COM Port (e.g. COM 1) where
your TNC is attached and click OK again.  Then select 9600 as your terminal baud rate and click
on OK.  NOTE: These are the only parameters you will need to enter or change.  Then press
<Enter>.

At this point you may see the cmd: prompt, which means that your TNC is in Terminal Mode, the
right serial port and baud rate has been selected, and you are able to communicate with it.  Or,
you may see a few characters including  ÀÀS00À, which means the TNC, is responding in Host
Mode.  If you don’t see anything at this point, turn the TNC off and then back on, and if you now
see several characters including ÀÀS00À, you are in Host Mode, indicating that the TNC is
working.

If only garbage-like characters are displayed, the right serial port has been selected, but the baud
rate selected is not correct.  Return to the setting screen, and select a different baud rate.

If nothing is displayed when the TNC is turned off and back on, the wrong serial port may have
been selected.  Return to the Settings screen and try a different serial port selection.  Make sure
the selected COM port is working correctly.  If HyperTerminal communicates OK through the
selected COM port to the TNC, PacTerm for Windows should also work.

If HyperTerminal can not communicate with the TNC, make sure the serial cable is connected
properly and make sure the TNC is turned on.  Make sure the serial port selected is not one that
is already in use by another device such as a mouse or modem.  Windows manages the COM
ports for these types of devices and will not allow proper operation of a TNC and PacTerm for
Windows.

OTHER ERRORS:

Application Errors caused by a ‘pointer gone astray’.  Many times, this could mean bad
memory, a bad spot on the hard disk or Windows is in some unknown state.  When this happens,
make sure your ‘TEMP’ directory on the hard disk has been cleaned out (typically located under
C:\Windows\Temp in Windows 95 / 98/ Me) and run ScanDisk.  Details on how to do this can be
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found in the Windows online help.

Getting an Error during startup.  If you get any of the startup errors that a documented
elsewhere in this help (MON001, STAMP001, etc.), normally this means there is a
communication problem between PacTerm for Windows and your TNC.  Make sure the COM
port and baud rate designated in PacTerm for Windows match the port connected to the TNC and
the baud rate that is set in the TNC.  Also make sure the COM port where your TNC is attached
has no IRQ conflicts.

Scrolling text on the screen is erratic or letters appear ‘behind’ the splitter bar.  This may
happen with some video cards with some fonts.  To fix it, adjust the size of the splitter windows
by moving the splitter bar up and down to the size you want.  PacTerm for Windows will then
save that information.  If you cannot see the extended ASCII characters (i.e. box characters) on
the screen, pick a font (Like the “Video Terminal Screen” font) that supports the OEM character
set.

Some Error Messages that may occur during startup:

NU01 - Error, trying new user Mode.  This is a message that all attempts to communicate with
the TNC have failed.

MYCALL01 - TNC didn’t return MYCALL status after PacTerm for Windows sent the
MYCALL <Call Sign> command.

MYCALL02 - TNC didn’t return MYCALL status after PacTerm for Windows sent the
MYCALL <Call Sign> command after finding the MYCALL didn’t match the Call Sign in the
PacTerm for Windows .INI file

MON01 - TNC didn’t return MONITOR status after PacTerm for Windows sent the MONITOR
ON command

MCOM01 - TNC didn’t return MCOM status after PacTerm for Windows sent the MCOM ON
command

MCON01 - TNC didn’t return MCON status after PacTerm for Windows sent the MCON ON
command

STAMP01 - TNC didn’t return CSTAMP status after PacTerm for Windows  sent the CSTAMP
ON command

XECH001 - TNC didn’t return XMITECHO status after PacTerm for Windows sent the
XMITECHO ON command

STA001 - TNC didn’t return STATUS, status after PacTerm for Windows sent the STATUS
command
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Technical Support

Technical Support Options

If you need more information on Windows, please consult your Windows help, accessible from
the Windows Start menu.

You can also check our web site for information.  Our web site is http://www.cssincorp.com/
PacTerm.

Also check http://www.kantronics.com.

Email problems with the PacTerm for Windows documentation to docmaster@cssincorp.com

Support is provided via Phone at (256) 381- 6135

Via E-mail at support@cssincorp.com

Via newsgroups at news://news.cssincorp.com/kantronics.products.support.pacterm98

and news://news.cssincorp.com/kantronics.products.support.pacterm98.demomode

If you need more information on your TNC, please consult your Kantronics TNC Owners
Manual.
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